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Preface 

Introduction to Internet GIS 

It is well known that the Internet Age has arrived. The 19
th
 century was the era of the 

railway, the 20
th

 century was the era of the expressway, and the 21
st
 century is the era 

of the Internet. With the development of internet technology and the increasing 

requirements for GIS, it has become a certain trend for GIS development to help users 

browse, query, and analyze spatial data through the Internet.  

The Internet GIS is the integration of Internet technology and GIS. Through the World 

Wide Web, GIS functions can be extended and have become a popular tool. The 

Internet user can browse, query, or analyze spatial data and thematic maps by 

accessing the Internet at any node of the network. Therefore, GIS will step into every 

family in future.  

Internet GIS can be widely used to build WebGIS by scientific research institutes, 

governments, and enterprises through their respective intranets. Internet GIS is a 

distributed GIS solution that can be maintained easily. 

Internet GIS Characteristics 

Globalization: Any Internet user can take advantage of various GIS services by 

simply accessing the Internet GIS server through any World Wide Web node. The user 

can even update the GIS data through the Internet globally.  

Popularization: In the past, GIS was held and used only by few experts as a special 

tool and it is difficult to generalize its use because of high cost and difficult techniques 

involved. With the explosive development of the Internet, especially with the Internet 

services becoming more accessible to the public, Internet GIS provides a better 

opportunity for more users to use GIS. Moreover, the reduction of the economic and 



   

 

technological costs for the end-users has further extended the potential application 

range of GIS. 

Expandability: Internet GIS can be easily and seamlessly integrated with other 

service information thereby establishing a more flexible GIS application. 

Cross-platform: Before the emergence of Internet GIS, GIS software could not 

support cross-platform use. And at that time, many companies provided different GIS 

versions for different operating systems such as Windows, UNIX, Macintosh, etc. 

However, Now Internet GIS supports cross-platform development and can be directly 

run anywhere once programmed.        

Contents of This Book 

This book helps users to establish demonstrations of Web GIS system quickly by using 

the three development manners of SuperMap IS .NET----WebControl, AjaxControls, 

remote class library and WebService development. Readers will get a basic 

understanding and learn a convenient and swift way to develop an application using 

SuperMap IS .NET. 

In this Introductory Book, we describe how to build a WebGIS application and the 

entire development flow rather than going into details about all of the interface and 

functions of SuperMap IS .NET. If you want to know more details about the 

functionalities of SuperMap IS .NET, please refer to SuperMap IS .NET DEV. 
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1 Environment 

Requirement          

SuperMap IS .NET is based on .NET technology and has a B/S structure with two 

parts: the client and server. The server refers to the service programs and other related 

parts running on a website. The software runtime environment often refers to that of 

the server, which can be controlled by the service vendor. The client is the software 

used by the end user who visits the Internet. Usually, the client is a universal browser. 

Clients supported by SuperMap IS .NET include many types, with many devices and 

software. In many cases, the clients are browsers or any other software with access to 

the Internet. The SuperMap IS .NET client uses standard HTML/JavaScript and 

doesn‟t require any other additional software to be downloaded or plugged-in. The 

client configuration refers to the universal browser and has nothing to do with the 

hardware and operating system. Therefore, the default runtime environment of 

SuperMap IS .NET in the manual specifically refers to the runtime environment of the 

server. 

Chapter 
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1.1 Hardware  

1.1.1 Minimum Requirements   

 CPU: 600 MHz 

 RAM: 256MB 

 Hard Disk Capacity: 10GB 

 CD-ROM Driver 

 Network Adapter 

 VGA or Super VGA Display 

 Discrete Video Card with 32M RAM 

1.1.2 Recommended Configuration 

 Double CPUs: 2GHz and higher 

 RAM: 1G and higher 

 Free Disk Space: 40G and higher 

 CD-ROM drive; 

 Network Adaptor 100M minimum 

 VGA or Super VGA Display with 1024*768 resolution and higher 

 Discrete Video Card with RAM 64M and higher 

Notes: The SuperMap IS .NET installation program will check the available disk 

space of your computer. A Complete installation requires a disk space of about 300MB, 

while a Customized one requires about 100MB to 300MB. 
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1.2 Software Requirements  

1.2.1 Supported Operating systems 

SuperMap IS .NET supports Windows operating system, including Windows XP 

Professional (with SP2 or later version), Windows Server 2003 (with SP2), Windows 

Server 2008. The recommended operating system is Windows Server 2003(with SP2). 

1.2.2 Other Software Requirements  

Other required software to be installed includes: 

 Microsoft Internet Information Server 

 .NET Framework 3.5 SP1 

 SuperMap Objects (Runtime or Development Kit) 

 DirectX (Optional. Necessary when running programs developed by 

SuperMap IS .NET and SuperMap Objects application programs at the same 

time. You can download it from 

http://www.microsoft.com/downloads/details.aspx) 

 Microsoft Visual Studio 2008 or any other development tool. 

 

 

 

 

http://www.microsoft.com/downloads/details.aspx
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2 License Information 

Configuration 

2.1 License types of SuperMap IS .NET    

To meet the specific needs of different users, SuperMap IS .NET comes in two 

editions, Enterprise and Standard, that are provided in the same installation package 

and require different licenses to run. The two editions differ mainly in the 

functionalities supported. Users can select and take full advantage of the most suited 

edition according to their individual needs.   

Table 2-1: Supported Functionality in the Two Editions 

Module Function Standard Enterprise Notes 

Data 

Engine 

Spatial 

database 

engine 

√ √ Support large-scale 

DBMS, including 

Oracle\SQL Server\ 

DB2\Kingbase. 

Chapter 
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Module Function Standard Enterprise Notes 

Web 

datasource 

engine 

√ √ Support aggregating 

Web data sources, 

WMS/WFS services on 

the GIS service layer. 

Server 

Manager 

Logging √ √ The three levels of 

logging contain 

information about 

start/stop events as well 

as errors and warnings.  

Precache √ √ The GIS server will 

cache the maps based on 

the cache configuration 

file before clients 

request the maps, thus 

reducing response times. 

Service 

management 

√ √ Configure and manage 

GIS services through the 

Web page, including: 

creating/deleting/config

uring GIS servers; 

creating/deleting/config

uring application 

services; 

starting/stopping GIS 

services/cluster services; 

managing service logs; 

setting workspace 

directories; etc 
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Module Function Standard Enterprise Notes 

Map 

Service 

Map 

navigation 

√ √ Pan, zoom, full extent, 

etc. 

Projection on 

the fly 

√ √ Create maps in the 

specified projection. 

Coordinates 

transformation 

√ √ Transformation of 

coordinates between 

geographic and planar 

coordinates, and 

between geographic and 

display coordinates. 

Distance/Area 

Measurement 

√ √ Measure distances and 

areas. 

Legend √ √ Get map legend 

Thematic 

Mapping 

Dynamically 

√ √ Unique Values Map, 

Ranges Map, Graph 

Map, Dot Density Map, 

Graduated Symbols 

Map, Label Map, 

User-defined Map, Grid 

Map. 

Spatial Query √ √ Query objects based on 

spatial relationships. 

Attribute 

Query 

√ √ Support querying 

objects by attribution. 
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Module Function Standard Enterprise Notes 

Data 

Service 

Dataset/ 

Datasource 

Information 

√ √ Get dataset/datasource 

information 

Data 

Exploration 

√ √ Explore data and query 

data by 

location/attribution. 

Data Editing   √ Provide interfaces for 

adding/deleting/modifyi

ng data, which can be 

used for developing 

these data editing 

functions. 

Client-side 

Data Editing 

  √ Support interactively 

editing data, e.g. adding, 

modifying, and 

changing data, on the 

client side. 

Workspace/ 

Datasource 

Management 

  √ View workspace 

information; view, open, 

and close datasources; 

display, add, and remove 

maps. 

Cluster 

Service  

Cluster Service   √ Support multiple 

instances (servers) 

cluster.  

Cluster service registers 

multiple GIS services 
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Module Function Standard Enterprise Notes 

onto the cluster server 

and provides services to 

the clients through the 

same interfaces. The 

cluster server is 

responsible for 

assigning the load of 

requests to different GIS 

servers. The clients do 

not need to know they 

are served by which GIS 

server. 

Map 

Service 

Publishing 

SOAP Service √ √ SOAP  based Web 

services 

REST Service √ √ Publishing RESTful 

services (AjaxHandlers).  

WMS  √ √ Publishing WMS 

services 

WFS √ √ Publishing WFS 

services 

WCS √ √ Publishing WCS 

services 

KML √ √ Publishing KML 

services 

GeoRSS √ √ Publishing geographic 
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Module Function Standard Enterprise Notes 

location services in 

GeoRSS format 

Developme

nt Support 

.NET SDK √ √ The following are 

included: 

1. SuperMap Web 

controls used for Web 

application development 

2. SuperMap Services 

and custom engine 

interfaces for GIS 

application development 

3. Other .NET 

development kit. 

JavaScript 

SDK 

√ √ A JavaScript software 

developer kit for 

browser development 

Advanced 

Analyses 

Advanced 

spatial 

analyses 

  √ Provide advanced 

spatial analysis services, 

including buffer, 

overlay, and spatial 

operations. Spatial 

operations include: Clip, 

Erase, Identity, Intersect, 

Union, and Symmetrical 

Difference. 
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Module Function Standard Enterprise Notes 

Network 

Analyses 

(Public 

Transportation 

Analyses 

Included) 

  √ Provide analysis 

services based on 

network data. Network 

analyses include Finding 

Shortest Path, TSP 

Analysis, Closest 

Facilities, and Service 

Area. Public 

transportation analyses 

include Bus Transfer 

Analysis, and Querying 

Bus/Subway/Railway 

Stops and Routes. 

Raster 

Analyses 

  √ Raster 

Aggregation/Clip/Comp

arison/Algebraic 

Operation, 

Contours/Isoregions 

Extraction, Raster 

Reclassification/Resamp

ling, Raster Zonal 

Statistics, etc. 

3D Analyses   √ Slope/Aspect 

Calculation, Viewshed 

Analysis, Fill/Sink 

Calculation, Flow 

Direction, Flood 

Analysis, 3D Surface 

Distance/Area/Profile 
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Module Function Standard Enterprise Notes 

Calculation, etc. 

When SuperMap IS .NET server starts, it will read the license information first, 

following the PRI of Enterprise Edition, Standard Edition to seek for license 

information, and provide the corresponding service access according to the license 

type. If the user possesses multiple edition licenses of SuperMap IS .NET at one time, 

for example, both trial license of Enterprise Edition and formal Edition of Standard 

Edition, and configures the two licenses in License Manager. In this case, SuperMap 

IS .NET service will find the Enterprise Edition license first according to the PRI 

mentioned above, and provide the access for this edition.  If the user want to use the 

Standard Edition license rather than the former Enterprise Edition, the user need to 

eliminate the former Enterprise Edition in License Manager first.  

2.2 Configuring License 

The License Configuration tool can configure the licenses for the SuperMap product 

series. For the Windows operating system, two types of license configurations are 

available: by license file and by hardware key. 

2.2.1 License File 

The file license can be obtained from SuperMap by providing your computer name, 

company name, and user name. Ensure that you have obtained the license from 

SuperMap Software Co., Ltd. before you start to configure. 

1. After being installed successfully in the above section, the License Manager pops 

up. You can also open the License Manager by clicking Start->All Programs 

->SuperMap->SuperMap License Manager 6->License Manager 6 or by directly 

run the LicenseManager6.exe program located in %License Manager_HOME%\: 
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Figure 2-1 The License Configuration tool-License File 

2. Enter your computer name, company name and user name and find the .lic license 

file by clicking the  button: 
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Figure 2-2  License File Configuration 

3. Click the Verify button to check whether the license is valid; if so, the remark 

“Valid” will appear in the "State" column, as shown in Figure 2-3 below. 

Note that the license is valid only when the computer name, company name and user 

name are consistent with that you provided to apply for the license. 
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Figure 2-3 Verify 

4. Click the Save button to save the current configuration information in the 

configuration file SuperMapLic.ini. (For details about the configuration file, see 

1.1.3.). 

 



16                                                     License Information Configuration                                                        

Getting Started with SuperMap IS .NET 

 

Figure 2-4 Save - License File 

Check the boxes before the products that you want to license. Only the configuration 

information of the checked products will be saved in the configuration file. Products 

unchecked are not licensed to use. 

5. Click the Close button to exit the License Configuration tool. 

2.2.2 Hardware Key 

A hardware key is a license provided in the format of encryption key. 

There are four kinds of hardware keys available: the stand-alone key, the stand-alone 

time key, the network key and the network time key.  

The stand-alone key has only one license installed on the same computer with the 

relevant SuperMap product.  

The stand-alone time key is similar to the stand-alone key but with a time limit for 

use.  

The network key allows the software to be used by multiple licensed computers. You 
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only need to install the network key license on any computer (called license server) 

within the network and the other computers in the same network are all licensed to use 

the software. The number of licensed computers is determined by the network key.  

The network time key is similar to the network key but with a time limit for use. 

The time limit of the time key, usually six years, is controlled by the battery within the 

key. If the time key expires, you can apply to SuperMap Software Co., Ltd. to extend 

the time limit. The stand-alone key and the network key do not have any time limit, 

but note that you can‟t change the system time of the licensed computer.  

Before using the hardware key you must install the driver. Once you have successfully 

installed the driver you can plug the hardware key in the parallel port or USB port of 

the computer. Currently, SuperMap provides hardware keys of two companies: 

Aladdin and Sentinel. 

To use the Aladdin HASP stand-alone key and time key, you are required to install the 

key driver; to use the HASP network key and network time key, both the key driver 

and License Server software are required to be installed. Their locations are: 

 Key driver: SuperMap Installation directory\Support\Aladdin\ 

HASPUserSetup.exe  

 License Server: SuperMap Installation directory\Support\Aladdin 

\lmsetup.exe  

For the Sentinel hardware keys, you only need to install the key driver, which is 

located in SuperMap Installation directory\Support\ Sentinel\ Sentinel Protection 

Installer 7.5.0.exe.   

After installing the network key on the server, find the item "SentinelKeysServer" by 

opening the server management tools in Windows Control Panel > Administrative 

tools > Services". That server is the service program for network keys. Usually, the 

system will automatically run this service after the installation is completed. If not, 

please use the toolbar or click the shortcut on the right button to start.  
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1. Open the License Manager by clicking Start->All Programs->SuperMap-> 

SuperMap License Manager 6->License Manager 6 or by directly run the 

LicenseManager6.exe program located in %License Manager_HOME%\: 

 

Figure 2-5 License Configuration tool -Hareware Key 

2. Enter the name of the computer which has the hardware key or the IP address and 

select the version of the product: 
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Figure 2-6 Hareware Key Configuration 

3. Click the Query button and check the current license state. You can stop the query 

by clicking the Stop button. The bottom of the dialog box shows the key type, the user 

name and the information of the company: 
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Figure 2-7 Query 

4. Click the Save button to save the current configuration information in the 

configuration file SuperMapLic.ini. (For details about the configuration file, see 

1.1.3.). 
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Figure 2-8 Save -Hareware Key 

Check the boxes before the products that you want to license. Only the configuration 

information of the checked products will be saved in the configuration file. Products 

unchecked are not licensed to use. 

5. The product licenses you want to configure may be on different servers. In this 

case, just follow the above steps to configure the product licenses and click Save after 

each configuration session finishes. 

6. Click the Close button to exit the License Configuration tool. 

2.2.3 Configuration Management 

The License Configuration tool will create a configuration file SuperMapLic.ini 

located in %License Manager_HOME% \Program Files \Common 

Files\SuperMap\License. The file is accessed automatically each time the SuperMap 

software is launched, to enable the use of the software. You can manage the file 

through the Configuration Management tab. Any changes to the configuration will be 

updated in the file automatically. 
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1. On the Configuration Management tab, click the Refresh button, and the licensed 

SuperMap products as well as the License Mode, Expired Date, and other relevant 

information will be displayed: 

 

Figure 2-9 License Configuration tool -Configuration Management 

2. You can select any product and click the Delete button to delete the configuration 

for this product. The configuration file will be updated automatically. 
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Figure 2-10 Delete License Configuration 

3. Click the Close button to exit the License Configuration tool. 

2.3 Notice 

It is recommended that you exit all windows programs before running the driver setup 

program. 

1. When the setup is finished, the system will prompt you to restart your computer, 

and it is strongly recommended that you restart your computer. 

2. If you fail to install the driver for the hardware key with USB port , you can open 

Computer Management window in Administrative Tools of Windows Setting: "Control 

Panel-->Administrative Tools-->Computer Management" and click Device Manager 

item in the catalog tree on the left, and then right-click the Ports (COM&LPT) item on 

the right. Click Scan for hardware changes on the shortcut menu to search the 

hardware key. Reinstall the driver for the hardware key follow the wizard. If the 

hardware key driver setup is still unsuccessful, please restart the computer and try it 

again. 
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3. For the users who use the network keys, you need to install the key‟s driver on the 

server-side and also configure on the client-side. 

4. For the users who use the hardware key with parallel port, in order to not damage 

the computer and hardware key, please shut down the computer and unplug the power 

supply after setup of the driver. Then plug the key with parallel port into the computer, 

restart the computer, and start the service. 

5. If you fail to install the driver for hardware key of SuperMap IS .NET, please 

remove the former driver, and restart the computer, then install the driver again 

following the wizard.  If the hardware key driver setup is still unsuccessful, contact 

our company and ask for help. The telephone number is (0086)-10-82736655 and then 

transfer to Customer Service Department. 

6. If you fail to run the program after configuring on the client-side, you can run the 

NetStat command to check: 1) Whether the Internet is connected successfully 2) 

Whether there is another computer occupying the port of the server. If none of the 

above problems occurs, please contact the Technical Support Department of 

SuperMap (The telephone number is (0086)-10-82736655; transfer to the Customer 

Service Department.). 

7. There is a slight difference in the setup interface and steps for installation of the 

network keys on different operating systems. 

8. For the users who use the stand-alone key, it is suggested that you finish installing 

the driver before configuring the stand-alone key; for the users who use the network 

key, it is suggested that you make sure you have configured on the server-side before 

you configure on the client-side. 
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3 Configuring and 

starting map 

service  

Different from the previous version of SuperMap IS which had both a local desktop 

manager and a remote manager, SuperMap IS .NET integrates the two with a single 

manager for both local and remote management. The manager provided by SuperMap 

IS .NET manages GIS services through remote management website which can start, 

stop, and monitor all services of the host server. The parameters of GIS service can be 

configured here. In addition, the SuperMap IS .NET management website can monitor 

and manage programs and processes that are running on the computer. 

3.1 SuperMap IS .NET Manager  

A local user inputs the address of management website such as 

http://Localhost/IS/Manager or http://ServerName/IS/Manager in the address bar of IE 

browser and can visit the website without user validation. 

Chapter 
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The homepage of SuperMap IS .NET manager is a navigation page as shown in Figure 

3-1, through which a user can enter any service configuration page.  

 

Figure 3-1: The Start Page of Service Website 

3.2 Configuring SuperMap IS .NET 

Click IS Config on the left of the homepage to open the page in which the service 

parameters of SuperMap IS .NET can be configured. It includes system configuration 

parameters, configuration parameters of the GIS application server, and there is button 

of „Save‟ at the bottom of the page. Click „Save‟ to save the settings. You can also 

click the items on the left of the page which are organized in tree view to open the 

corresponding pages and configure parameters.  

The applications in Chapter 4 use the default setting of the SuperMap IS .NET, click 

Map Settings on the left of the IS Config page as shown in Figure 3-2, you can set the 

path of the workspace which will be published, then click the Save button at the 

bottom of the page to save the information.     
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Figure 3-2: The MapSetting page 

3.2.1 Starting map service 

Before using the GIS functionalities provided by SuperMap IS .NET, you should start 

the map service first by following any of the two ways below: 

Method 1: Starting from Start Menu 

Click Start->Programs->SuperMap->SuperMap IS .NET->SuperMap IS .NET Service 

Controls->Start Service. 

Method 2: Starting from IS .NET Manager 

The administrator can start service directly, the procedure is as follows: First return to 

the homepage of the web site, then click service to enter Services page, and find the 

SuperMap IS Server Manager item. If the prompt information is stopped , it means the 

service is stop running, and if you want to start the service, click stop/start button to 

open service management window, as shown in Figure 3-3 and Figure 3-4, select Start 

Service option and click the submit button, the service will be started. You can stop the 

service in the same way, except selecting Stop Service instead of Start Service.   
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When SuperMap IS Server Manager is running, you don‟t need to restart service even 

if the parameters of map information have been modified, this is because the service 

management of SuperMap IS .NET has the characteristic to allow modifying the 

service parameters dynamically without interrupting the GIS service. 

 

Figure 3-3: Start IS service 

 

Figure 3-4: Start/Stop service page 
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4 Creating Web 

Applications 

Six development manners of SuperMap IS .NET to create service GIS system have 

been introduced in this section, all of them are WebControls, WebLib, AjaxControls, 

AjaxScripts, WebService and Web component libraries. 

4.1 Developing Web applications with 

WebControls 

This section gives a demonstration of development with WebControl using Microsoft 

Visual Studio 2008 as the development tool and C#.NET as the programming 

language. You can learn the following contents in this chapter: 

 Loading SuperMap IS WebControls into your webpage 

 Displaying maps by using MapControl 

 Navigating on the map with the frequently used tools: Zoom In/Out and Pan, 

etc. 

Chapter 
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 Identifying features 

 Finding and selecting features with a Structured Query Language(SQL) 

expression 

Note: You can find the source codes of all the functions mentioned in this chapter in 

SMISStepByStepCS project (SMISStepByStepCS.csproj) which is located 

in<SuperMap IS .NET Installation Directory>\Getting Started\SMISStepByStepCS.  

Step 1: Building a new web application 

1. Launching Visual Studio 2008 

2. Creating a new web application 

Microsoft Visual Studio 2008 is used as the development environment which supports 

many different programming languages. Various types of ASP.NET Web Application 

can be created. A Visual C# Web Application is created as an example here. To create a 

new web site, click File>New> Web Site, and a New Web Site dialog box will pop up, 

as showed in Figure 4-1. Select ASP.NET Web Site from the above Templates box and 

at the bottom of the dialog box, set the Location to be HTTP, and the website address 

to be http://localhost/SMISStepByStep, and the Language to be Visual C#. Click OK 

to complete creating a new web site, and the SMISStepByStep website will be 

automatically created.   

 

 

http://localhost/SMISStepByStepCS
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Figure 4-1: Creating a new web site 

Step 2: Loading SuperMap IS WebControls 

After creating the new web site, a default.aspx window will be displayed. Click the 

General tab on the Toolbox window to add SuperMap IS WebControls. Usually any 

tab can be chosen to add SuperMap IS WebControls to, but for the convenience of 

management and usage, a blank tab has been chosen. Right-click the General tab and 

click Choose Items... on the shortcut menu (Figure 4-2), then the Choose Toolbox 

Items dialog box will pop up. 
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Figure 4-2: Loading Controls 

Click the Browse button to browse for SuperMap.IS.WebControls.dll, which can be 

found in the [SuperMap IS .NET installation]\ WebSDK\WebControls folder (Figure 

4-3). Then click OK to complete adding the SuperMap IS Webcontrols. 

If the WebControls are added successfully, SuperMap IS WebControls will appear in 

the ToolBox window (Figure 4-4).  
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Figure 4-3: Loading WebControls Figure 4-4: SuperMap IS 
webControls 

Step 3: Creating the homepage 

Most functions of SuperMap IS .NET are encapsulated as ASP.NET WebControls, 

which improves the speed of programming. Using SuperMap IS WebControl to 

implement WebGIS functionality in a Web GIS application is similar to using 

SuperMap Objects to build a GIS project. You can implement Web GIS functions 

conveniently by using properties, methods and events defined by SuperMap IS 

WebControls. The following step is to create an application homepage for 

the SMISStepByStep website and load a set of basic SuperMap IS WebControls to it. 

1. Creating an application homepage 

A web page named Default.aspx was created as the application homepage when you 

create a new web site. Right-click Default.aspx in the Solution Explorer window and 

click Set As Start Page on the shortcut menu as shown in Figure 4-5, then double 

-click Default.aspx to open this window. 
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Figure 4-5:Setting Start Page Figure 4-6: Loading a map 

2. Loading controls  

There are two ways to load controls onto the web page. One is to click Control icon in 

the Toolbox window and drag it to the web page and drop it; the other way is to 

double-click the control icon to load the control automatically onto the page and you 

can change its size and position manually. By using either of the two ways mentioned 

above, the MapControl has been loaded first and its Width and Height should be set in 

the Properties window. As shown in Figure 4-6 and Figure 4-7 below, MapControl has 

been loaded into the homepage. If the SuperMap IS service has already been started, 

the MapControl can display a map published by SuperMap IS service while designing. 

The procedure is as follows: right-click the MapControl on the homepage and click 

Load Map, type IP address and Port of Map Server in the pop-up MapControl Editor 

dialog box, then the maps published by the Map Server will appear in the dropdown 

map list. Select one of the maps you want to load to the homepage, and click the 

Preview button, and then the map will be displayed below. Click OK and the map will 

be displayed in the MapControl on the homepage. 
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Figure 4-7:Displaying the map Figure 4-8:The Runtime Result 

3. Runtime test 

Now run and test the web GIS site locally, though any code haven‟t written for the 

web site. Select the Start Debugging in the Debug menu or click 

on the toolbar or press F5 key. The running result is shown in Figure 4-8, from which 

the map is displayed on the web page. The following step is to implement map browse 

functionality such as zooming and panning in the project. 

Step 4: Implementing the basic map browse 

functionality  

The basic map browse functionality includes panning, zooming in, zooming out and 

zooming to the full extent of the map.  

1. Loading controls 

The following SuperMap IS WebControls can implement the basic map browse 

functions: 

 Fixed Zoom In: QuickZoomInToolControl  

 Fixed Zoom Out: QuickZoomOutToolControl  
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 Zoom In: ZoomInToolControl  

 Zoom Out: ZoomOutToolControl  

 Pan : PanToolControl  

 Full Extent: ViewEntireToolControl  

The steps how to load the SuperMap IS WebControls onto the webpage has been 

introduced in Step 3. All the above controls can be loaded onto the webpage in the 

same way, and their functions can be implemented without attaching any code. 

2. Runtime test 

Click the Run button to test the basic map browse functions. The running result is 

shown in Figure 4-9 and the buttons below the map in turn (from left to right) are Full 

Extent, Zoom In, Zoom Out, Fixed Zoom In, Fixed Zoom Out and Pan. Click any of 

the buttons to operate over the map and test the functions of the buttons. 

 

Figure 4-9: Basic Map Browse Functions 
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Step 5: Querying features by SQL     

Querying features by SQL is one of the basic GIS functions. There are two main query 

manners: one is finding and selecting features with a Structured Query Language 

(SQL) expression of attribute fields and the other is querying the related attribute 

information for identified features. In this step, the former one----selecting the features 

by searching with an SQL expression is introduced here. It is a fuzzy query. It can 

select all features in a specified layer, which is called a query layer, according to the 

criteria you entered which consists of one or more attribute fields, operators, and 

calculations (World_countries@world layer is set as the QueryLayer). The query 

result will be displayed in a table view on the webpage and the selected features will 

be highlighted on the map. 

1. Loading controls 

You need to load the following controls (Figure 4-10) onto the webpage which are 

used to perform the query function. 

 

Figure 4-10: Query Features by SQL 

Add a TextBox to the web page and set its ID to txtQuery in the Properties window 

for inputting.  

Add a Button to the web page and set its ID to btnQuery for submitting the query 
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statement.  

Add a DataGrid and set its ID to dgResult for displaying the query results. 

Add a Label control and set the Text property as Query.   

2. Attaching code 

First of all, add the following code to Default.aspx: 

using SuperMap.IS.Utility; 

using SuperMap.IS.WebControls; 

Secondly, add the following code to the Click event of the btnQuery button: 

     protected void btnQuery_Click(object sender, System.EventArgs e) 

    { 

         //Define a QueryParam object named queryParam from which you can 

set query layer, query condition, and specified return field values. 

         QueryParam param = new QueryParam(); 

         //Set whether to query all layers or not. If its value is false, 

you should set the query condition to every query layer separately.  

         param.IsAllLayer = false; 

         //Create a new instance of QueryLayer class. 

         QueryLayer queryLayer = new QueryLayer(); 

         //Set fields to return. 

         queryLayer.ReturnFields = new string[2]; 

         queryLayer.ReturnFields[0] = "SMID";  

         queryLayer.ReturnFields[1] = "Country"; 

         //Set the query layer’s name and query condition.  

         queryLayer.Name = "World_countries@world"; 

         queryLayer.WhereClause = "Country like '*"+ this.txtQuery.Text 

+"*'";    

          

         param.Layers = new QueryLayer[1];     //<line9> 

         param.Layers[0] = queryLayer; 

         //Set whether to highlight the geometric objects on the map or 
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not. 

         param.Highlight.HighlightResult = true; 

         //Perform query function by using MapControl.QueryBySql and 

save the result in resultSet.                      

         ResultSet Rs = MapControl1.QueryBySQL(param); 

         //Bind the result to the DataGrid to display.  

         DataSet ds = Rs.ToDataSet();     

         dgResult.DataSource = ds;   

         dgResult.DataBind();    

     } 

Note: You can add the code below to Page_load event. If you do not want to preserve 

the highlights on the map when performing another query. 

    protected void Page_Load(object sender, EventArgs e) 

    { 

        //clear highlight 

        MapControl1.ClearHighLight(); 

    } 

3. Runtime test 

Run the project following the related parts in step 3. Type Canada in the textbox and 

click Query. It will return all the records which contain Canada in NAME field of 

world_countries@World layer and the values of SMID and NAME of the records will 

be displayed in the DataGrid. The related geometries are highlighted on the map as 

shown in Figure 4-11.  
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Figure 4-11:Querying a specific area 

Step 6: Querying attributes by identifying features 

Identifying features is another way to query geographic database. SuperMap IS .NET 

provides a number of ways to query the attributes of features such as identifying 

features selected by rectangles, polygons, circles or by clicking them on the map.  

In the beginning, you need to set the query layer and query parameters such as which 

fields you desire to return. Secondly, you need to set the query method, that is, in 

which manner you select the features you want to identify, by point, rectangle, circle 

or polygon. Finally, represent the results in a table view on the user interface.  

The following steps will guide you through the process of querying attributes by 

identifying features in four manners. 

1. Adding buttons for query  

Add four HTML buttons to the right hand side of the map which are used to perform 

the four different selections. Set the Value values of the four buttons to be PointSelect, 

RectSelect, CircleSelect and PolygonSelect as shown in Figure 4-12, which means 

select the features by clicking them, dragging a rectangle, a circle or a polygon, 
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respectively. 

 

Figure 4-12: Adding Query Buttons 

2. Attaching code to the buttons 

Click the Source tab at the bottom of the webpage to switch the web page to HTML 

style. Set the onclick properties of the above four buttons as follows with italic codes 

respectively. 

     <input id="btnPointQuery" style="left: 640px; width: 64px; 

position: absolute; top: 89px" type="button" 

onclick="SMISActionStart('MapControl1','POINTQUERY');" 

value="POINTQUERY" /> 

     <input id="btnRectQuery" style="left: 725px; width: 64px; position: 

absolute; top: 89px" type="button" 

onclick="SMISActionStart('MapControl1','RECTQUERY');" 

value="RECTQUERY" />  

     <input id="btnCircleQuery" style="left: 640px; width: 64px; 

position: absolute; top: 126px" type="button" 

onclick="SMISActionStart('MapControl1','CIRCLEQUERY');" 

value="CIRCLEQUERY" /> 

     <input id="btnPolygonQuery" style="left: 726px; width: 64px; 

position: absolute; top: 126px" type="button" 

onclick="SMISActionStart('MapControl1','POLYGONQUERY');" 

value="POLYGONQUERY" />  

3. Attaching code to display the results 

At first, set the map layer and related parameters for querying in the code before 



42                                                         Creating Web Applications 

Getting Started with SuperMap IS .NET 

querying. MapControl provides a special event that will be triggered before querying, 

that is MapControl1_Querying (object sender, 

SuperMap.IS.WebControl.EventArguments.QueryParamArgs e). 

Therefore, the process of setting query parameters should be performed in this event. 

The code is as follows: 

     protected void MapControl1_Querying(object sender, 

SuperMap.IS.WebControls.EventArguments.QueryingEventArgs e) 

     { 

         //Set whether to highlight geometric objects on the map or not. 

         e.Params.Highlight.HighlightResult = true; 

         // create a new instance of QueryLayer class.  

         e.Params.Layers = new QueryLayer[1]; 

         e.Params.Layers[0] = new QueryLayer(); 

         //set layers to be query 

         e.Params.Layers[0].Name = "world_countries@World"; 

         //set the field value to return.  

         e.Params.Layers[0].ReturnFields = new string[2]; 

         e.Params.Layers[0].ReturnFields[0] = "SMID"; 

         e.Params.Layers[0].ReturnFields[1] = "Country"; 

     } 

Secondly, display the query result by adding the related code in the QueryCompleted 

event of the MapControl. In order to present the result on the client side, the returned 

results to the DataGrid should be bound in the MapControl1_QueryCompleted event. 

    protected void MapControl1_QueryCompleted(object sender, 

SuperMap.IS.WebControls.EventArguments.QueryCompletedEventArgs e) 

    { 

        ResultSet rs = new ResultSet(); 

        rs.Recordsets = e.Recordsets; 

        rs.TotalCount = e.TotalCount; 

        DataSet ds = rs.ToDataSet(); 

        dgResult.DataSource = ds; 
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        dgResult.DataBind(); 

    } 

4. Runtime test 

Run the project as described in Step 3 and zoom in the map. Click the RectSelect 

button and Position the cursor at one corner of the area from which the selection will 

be made on the map and press the mouse button. Keep the mouse button depressed 

and drag the cursor away from the starting point. Release the mouse button when the 

rectangle reaches the desired size. All of the objects whose centroids are within the 

rectangle are highlighted. The returned results will be shown in the dgResult control in 

the lower-right corner of the webpage (Figure 4-13). You can perform identifying 

features by selecting them in the other way, for example, using the CircleSelect and 

PloygonSelect buttons, which are similar to the way the RectSelect button works to 

test the related query functions. 

 

Figure 4-13:The Results of the Query 

4.2 Developing Web applications with WebLib 

This section gives a demonstration using Microsoft Visual Studio 2008 as the 

development environment and C#.NET as the programming language to develop with 
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TCPMap and you can learn the following contents from this section: 

 Connecting with remote map service 

 Displaying maps by using TCPMap 

 Navigating on the map with the frequently used tools: Zoom In/Out and Pan, 

etc. 

 Querying attributes by identifying features 

 Finding and selecting features with a Structured Query Language (SQL) 

expression 

Note: You can find the source codes of all the functions mentioned in this chapter in 

WinFormClient project which located in <SuperMap IS .NET Installation 

directory>\Demo\WinFormClient folder. 

Step 1: Creating a new windows application project 

Start Visual Studio 2008 development environment. In the Visual Studio 2008 user 

interface, click File > New > Project, and a New Project dialogue box will pop up as 

shown in Figure 4-14. Select Windows Application (Figure 4-14-(1)) from the right 

Templates box and Visual C# (Figure 4-14-(2))from the left Project types box, then 

type the name and location of the project (Figure 4-14-(3)) in the Name and Location 

input boxes, and click OK. A form named Form1 will be created in the project by 

default: 
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Figure 4-14: Creating a new project 

Step 2: Connecting to map server and accessing map 

information 

To implement map browse functionality, the remote map class library should be 

connected to the map server first, so that it can intercommunicate with map server 

using TCP communication protocol to access map information. The TcpMap.Create ( ) 

method will be used to seek the map server according to the map server address and 

port typed by the user on client-side. If the map service is accessible, the list of maps 

published by this map server will be available.  

1. Loading controls 

Load a GroupBox, three Labels, two TextBoxes (for typing address and port of the 

map server), a Combobox and a button onto Form1 in Form1.cs[design] page layout 

respectively, and set the Text of the GroupBox to Map Server, the Text value of the 

three Label controls to Address, Port, Map Name respectively, the Name of the two 

TextBoxes to tbServerAddress and tbServerPort, the Name of the Combobox to 

cbMapNames and the Name of the Button to btnVaidate, the Text of the Button to 

Validate. The interface is shown in Figure 4-15. 
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Figure 4-15: Connecting the map server Figure 4-16: Adding References 

2. Adding references 

Add SuperMap IS .NET class library references in the project. These references can be 

found in [SuperMap IS .NET Installation folder]\WebSDK\AjaxControls folder in 

your SuperMap IS .NET installation location. The referenced class library includes 

SuperMap.IS.ServiceInterface.dll, SuperMap.IS.Utility.dll and 

SuperMap.IS.Weblib.dll. The following reference code should be added to Form1.cs:  

using SuperMap.IS.Utility; 

using SuperMap.IS.ServiceInterface; 

using SuperMap.IS.Web; 

using System.Collections; 

3. Adding code to validate 

When clicking the Validate button, TCPMap will connect to the remote map server 

according to the typed map server address and port, obtain the map list published by 

remote map server, and display it in Combobox of Map Name. The code to validate is 

as follows: 

First define IMap object in class Form1, the procedure is as follows:  

Click Form.cs to open the Form.cs page layout, and add the following code to it: 
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   public partial class Form1 : Form 

    { 

        //Define remote map communication object to perform  

//intercommunication with remote map 

        private IMap m_map; 

Next, add code to implement validation function in the Click event of btnValidate 

button, and the procedure is as follows: Double-click the btnValildate button in the 

Form1.cs[Design] page layout, which will navigate to the Click event of the 

btnValidat button, and add the following code to the event: 

     private void btnValidate_Click(object sender, EventArgs e) 

     { 

         string inputAddress; 

         int inputPort; 

         //Obtain address of the map server. 

         inputAddress = this.tbServerAddress.Text; 

         //Validate whether the typed address and port are available. 

         if (inputAddress.Length == 0 

|| !int.TryParse(this.tbServerPort.Text, out inputPort)) 

         { 

             return; 

         } 

         try 

         { 

             //Establish local connection of TcpMap according to the 

address and port of the map server. 

             m_map = TcpMap.Create(inputAddress, inputPort, new 

Hashtable()); 

             //Obtain the list of maps published by the map server using 

the IMap.GetMapNames method. 

             string[] mapNames = m_map.GetMapNames(); 

             //Place the map list to the ComboBox. 

             this.cbMapNames1.DataSource = mapNames; 

         } 
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         //If the connection fails (for example: the map server does not 

exist), display the exception information. 

         catch (Exception ex) 

         { 

             MessageBox.Show(ex.Message, "Exception"); 

         } 

     } 

4. Runtime test 

Make sure that SuperMap IS .NET map service has been started successfully before 

running the program. 

Select the Start Debugging in the Debug menu or click on the 

toolbar or press F5 key to run the program. Type the Address and Port of SuperMap 

IS .NET map server in the Form1 window, and click Validate, then the list of maps 

published by the map server will be appear in the left Combobox, the running result is 

shown in Figure 4-17. 

  

Figure 4-17: The Runtime Rresult Figure 4-18: Add map display controls 

Step 3: Displaying a map 

1. Loading controls 

Add a Button, a PictureBox (for displaying the map) and a Label (for displaying map 
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status) onto Form1 in Form1.cs [design] page layout respectively, and set Name of 

the button to btnOK, and the Text of the button to Display Map. The interface is 

shown in Figure 4-18. 

2. Adding code to display map 

First define MapImage object in class Form1, the procedure is as follows:  

Click Form.cs to open the Form.cs page layout, and add the following code to it: 

       public partial class Form1 : Form 

      { 

        //Define remote map communication object 

        private IMap m_map; 

        //Define map description object 

        private MapImage m_image; 

To display a map, that is when clicking the Display Map button, the map will be 

displayed in PictureBox, and the map information will be displayed in the Label, the 

following code is used to implement map display function in the click event of the 

btnOK button, and the procedure is as follows: Double-click the btnOK button in the 

Form1.cs [Design] page layout, which will navigate to the Click event of the btnOK 

button, and add the following code to the event: 

     private void btnOK_Click(object sender, EventArgs e) 

     { 

         //Set the number of historical operations to save. 

         m_map.HistoryLength = 7; 

         //Define the object of map parameters (such as scale, centre 

point, map extent  

         MapParam mp = new MapParam(); 

         //Define the size of map to accord with PictureBox.  

         mp.Viewer.LeftTop.X = 0; 

         mp.Viewer.LeftTop.Y = 0; 

         mp.Viewer.RightBottom.X = this.pictureBox1.Width; 
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         mp.Viewer.RightBottom.Y = this.pictureBox1.Height; 

         //Set the name of the map to display. 

         mp.MapName = this.cbMapNames.Text; 

         //Set whether to return the layer information of the map  

         mp.ReturnLayers = true; 

         //IMap object obtains related map from map server according to 

the set map parameters, and returns the map and its related information 

description, including the address of the map.  

         m_image = m_map.GetMapImage(mp); 

         RefreshStatus(m_image); 

     } 

     //Refresh the map status. 

     private void RefreshStatus(MapImage image) 

     { 

         //Judge whether to return the map information or not  

         if (image == null) 

         { 

             this.label4.Text = string.Empty; 

             return; 

         } 

         else 

         { 

             //Place the returned map to the PictureBox to display. 

             this.pictureBox1.ImageLocation = image.MapUrl; 

             //Display the address of the map in the Label.  

             this.label4.Text = image.MapUrl; 

         } 

     } 

3. Runtime test 
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Figure 4-19: The Runtime Rresult 

Run the program the way described in Step 2, Type the Address and Port of SuperMap 

IS .NET map server in the Form1 window (Figure 4-19-(1)), and click Validate 

(Figure 4-19-(2)), then the list of maps published by the map server will appeared in 

the left Combobox(Figure 4-19-(3)). Select the map you want to display, and click the 

Display Map button (Figure 4-19-(4)), then the map will be displayed in the right 

PictureBox, as shown in the Figure 4-19. 

Step 4: Implementing map browse functionality 

The basic map browse functionality includes zooming to the full extent of the map, 

zooming in, zooming out, which can be implemented by using the ViewEntire, zoom, 

pan (or PanByPixel) methods of IMap. 

1. Loading controls 

Add nine buttons onto Form1 in Form1.cs[design] page layout to implement the 

functions of zooming to the full extent of the map (Name of the button: 

btnViewEntire), zooming in (Name of the button: btnZoomIn), zooming out (Name 

of the button: btnZoomOut), moving up (Name of the button: btnUp), moving down 

(Name of the button: btnDown), moving left (Name of the button: btnLeft) , moving 

right (Name of the button: btnRight), zooming to the last extent (Name of the button: 
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btnPre), and zooming forward from a previous extent (Name of the button: btnNext) 

as shown in Figure 4-20. 

 

Figure 4-20: Adding map browse controls 

2. Adding code to browse map 

When clicking different map browse buttons, the map in the PictureBox will change 

correspondingly according to the relevant function of the button. Double-click the map 

browse buttons in Form1.cs [Design] page layout respectively to navigate to the Click 

event of related button, and add the following code to them, respectively.  

     // Zoom to the full extent of the map 

     private void btnViewEntire_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.ViewEntire(string.Empty); 

         RefreshStatus(m_image); 

     } 

     // Zoom in the map 

     private void btnZoomIn_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.Zoom(2); 

         RefreshStatus(m_image); 
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     } 

     // Zoom in the map 

     private void btnZoomOut_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.Zoom(0.5); 

         RefreshStatus(m_image); 

     } 

     // Move the map to the left 

     private void btnLeft_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.PanByPixel(-this.pictureBox1.Width / 3, 0); 

         RefreshStatus(m_image); 

     } 

     // Move the map to the right 

     private void btnRight_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.PanByPixel(this.pictureBox1.Width / 3, 0); 

         RefreshStatus(m_image); 

     } 

     // Move up the map 

     private void btnUp_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.PanByPixel(0, this.pictureBox1.Height / 3); 

         RefreshStatus(m_image); 

     } 

     // Move down the map 

     private void btnDown_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.PanByPixel(0, -this.pictureBox1.Height / 3); 

         RefreshStatus(m_image); 

     } 

     // Previous view of the map 
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     private void btnPre_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.ViewPrevious(); 

         RefreshStatus(m_image); 

     } 

     // Next view of the map 

     private void btnNext_Click(object sender, EventArgs e) 

     { 

         m_image = m_map.ViewNext(); 

         RefreshStatus(m_image); 

     }  

3. Runtime test 

Run the program as described in Step 2, Type the Address and Port of SuperMap 

IS .NET map server in the Form1 window, and click Validate, then the list of maps 

published by the map server will appear in the left Combobox. Select the map you 

want to display, and click the Display Map button, then the map will be displayed in 

the right PictureBox. Click different map browse buttons, and the map in the 

PictureBox will change correspondingly as shown in Figure 4-21. 
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Figure 4-21: The Runtime Result 

Step 5: Querying features by SQL 

The function of querying features by SQL can be implemented by the QueryBySQL 

method of IMap class. The procedure is as follows: 

1. Loading Controls 

Add a Label, a Textbox (for typing SQL query condition), a GroupBox(set the Text 

value is SQL Query), a button (for implementing SQL query) onto Form1 in 

Form1.cs[design] page layout, and set the Name of the button to btnSQL. 
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Figure 4-22: Adding DataGrid 

Add a DataGrid: Add the DataGrid control to the Toolbox, as shown in Figure 4-22, 

and load it onto Form1 in Form1.cs [design] page layout. 

The design interface is shown in Figure 4-23. 
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Figure 4-23: The Design Interface 

2. Adding code to query 

Double-click the btnSQL button in the Form1.cs[Design] page layout, which will 

navigate to the Click event of the btnSQL button, and add the following code to the 

event:  

     private void btnSQL_Click(object sender, EventArgs e) 

     { 

         //Define the Querylayer object. 

         QueryLayer querylayer = new QueryLayer(); 

         // Obtain MapParam object of current map. 

         MapParam mapParam = m_map.GetCurrentMapParam(); 

         //Set the query layer. 

         querylayer.Name = mapParam.Layers[1].Name; 

         //Set the condition statement of query layer. 

         querylayer.WhereClause = this.txtSQL.Text; 

         //Define QueryParam object. 

         QueryParam queryparam = new QueryParam(); 

         queryparam.Layers = new QueryLayer[1]; 

         //Evaluate queryparam with querylayer defined above. 

         queryparam.Layers[0] = querylayer; 

         //Implement SQL query. 

         ResultSet rs = m_map.QueryBySql(queryparam); 

         //Judge whether there are records to return. 

         if (rs.TotalCount > 0) 

         { 

             DataSet ds = new DataSet(); 

             //Translate the return result to DataSet type. 

             ds = rs.ToDataSet(); 

             //Display result in dataGrid1. 

             this.dataGrid1.DataSource = ds; 
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             this.dataGrid1.Refresh(); 

             //Expand the result. 

             this.dataGrid1.Expand(-1); 

             //Refresh the status of map. 

             RefreshStatus(rs.MapResult); 

         } 

     } 

3. Runtime test 

Run the program as described in Step 2, Type the Address and Port of SuperMap 

IS .NET map server in the Form1 window (Figure 4-24-(1)), and click Validate 

(Figure 4-24-(2)), then the list of maps published by the map server will appear in the 

left Combobox. Select the map you want to display, and click the Display Map button 

(Figure 4-24-(3)), then the map will be displayed in the right PictureBox. Type the 

query condition in the Condition input box (Figure 4-24-(4)), and click the Query 

button (Figure 4-24-(5)). The query result will be displayed in the Datagrid at the 

bottom of the form, and the related features will be highlighted on the map. 
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Figure 4-24: The Runtime Result 

Step 6: Querying attributes by identifying features 

Query by point-select is one of the methods of identifying features, that is, when 

clicking a position on the map to select a query point and a search circle will be drawn 

around the query point. The query result will be the features around the query point in 

the query layer. Usually, the method IMap.QueryByPoint() as well as 

IMap.QueryByDistance() will be used to implement this function. 

1. Loading Controls 

Add a RadioButton to Form1 in Form1.cs[design] page layout, and set its Name to 

rbtnPoint, and Text to Point-Select Query. 

Add a GroupBox (set the Text value is Identify attributes of feature). 

2. Adding code for query 

To implement the point-select query, the MouseUp event of the PictureBox will be 

applied. Select the pictureBox1 on Form1 in Form1.cs[design] page layout, and 

right-click to select Properties on the shortcut menu, then the Properties window of 

pictureBox1 will appear as shown in Figure 4-25. 
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Figure 4-25: Launching the MouseUp event 

Click the button as shown in Figure 4-25-(1) on the Properties window to display 

event list of PictureBox1, and double-click MouseUp event (Figure 4-25-(2)), which 

will navigate to the MouseUp event of pictureBox1. Add the following code to the 

event: 

     private void pictureBox1_MouseUp(object sender, MouseEventArgs e) 

     { 

         //Judge whether to implement point-select query or not. 

         if (rbtnPoint.Checked) 

         { 

             //Judge whether a map exists or not. 

             if (m_map == null) 

             { 

                 return; 

             } 
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             //Obtain the pixel coordinates of query point selected by 

pointer. 

             PixelCoord queryPoint = new PixelCoord(e.X, e.Y); 

             //Translate from the pixel coordinates of query point 

selected by pointer to map coordinates 

             MapCoord mapCoord = 

Convertor.PixelCoordToMapCoord(queryPoint, 

m_map.GetCurrentMapParam()); 

             //Define the object to query. 

             QueryParam queryParam = new QueryParam(); 

             //Set the maximum record numbers to return when querying. 

             queryParam.ExpectCount = 10; 

             //Set whether to highlight the returned result. 

             queryParam.Highlight.HighlightResult = true; 

             //Set whether to highlight the queried area. 

             queryParam.Highlight.HighlightQueryArea = true; 

             //Set whether to query all layers or not. 

             queryParam.IsAllLayer = true; 

             //the parameter 5 means the distance tolerance of map 

coordinate, can not less than 0. 

             ResultSet rs = m_map.QueryByPoint(mapCoord, 5, 

queryParam); 

             if (rs != null && rs.MapResult != null)      

             { 

                 DataSet ds = new DataSet(); 

                 // Translate the result returned to the DataSet type. 

                 ds = rs.ToDataSet(); 

                 //Display the result in DataGrid.  

                 this.dataGrid1.DataSource = ds; 

                 //Refresh the result. 

                 this.dataGrid1.Refresh(); 

                 //Expand the result. 

                 this.dataGrid1.Expand(-1); 

                 //Refresh the status of map. 
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                 RefreshStatus(rs.MapResult); 

             } 

         } 

     } 

3. Runtime test 

Run the program as described in Step 2, type the Address and Port of SuperMap 

IS .NET map server in the Form1 window (Figure 4-26-(1)), and click Validate 

(Figure 4-26-(2)), then the list of maps published by the map server will appear in the 

left Combobox (Figure 4-26-(3)). Select the map you want to display, and click the 

Display Map button (Figure 4-26-(4)), then the map will be displayed in the right 

PictureBox. Select the Point-Select Query button (Figure 4-26-(5)), and click on the 

map to place a query point. The query result will be displayed in the Datagrid at the 

bottom of the form (Figure 4-26-(7)), and the related features will be highlighted on 

the map (Figure 4-26-(6)). 
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Figure 4-26: The Runtime Result 

4.3 Developing LBS applications with WebLib 

In this section, you will learn how to develop LBS (Location Based Service) 

applications with WebLib in Microsoft Visual Studio 2005 using C#.NET. LBS 

applications are accessible with mobile devices. 

 Add WebLib reference;  

 Display maps using TcpMap;  

 Navigate maps using TcpMap;  

 Perform SQL query 

Step 1: Create a new website 

Start Microsoft Visual Studio 2005. Click【File】->【New】->【Web Site】. Select 

ASP .NET Web Site (Figure 4-27), select File System from the Location dropdown list 

and enter the web site, for example, "WebMobileDemo", in the textbox. Select Visual 

C# from the Language dropdown list and click OK. The WebMobileDemo web site is 

created (Figure 4-28). 
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Figure 4-27: New Web Site Figure 4-28: Add New Item 

Step 2: Add Web Mobile Form 

In the Solution Explorer, right-click WebMobileDemo and select Add New Item from 

the popup menu. Select Mobile Web Form from Visual Studio installed templates. 

Type a name for the form, e.g. WebMobile.aspx. Select Visual C# from the Language 

dropdown list. Click Add. The Mobile Web Forms tab (Figure 4-30) is added to the 

Toolbox and a control named Form1 is added automatically to the WebMobile.aspx 

page. 
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Figure 4-29: New Item Figure 4-30: The Mobile 

Web Forms Tool Box 

Step 3: Add reference 

Add SuperMap IS .NET class library references to the project. These references can be 

found in the [SuperMap IS .NET Installation folder]\WebSDK\AjaxControls folder. 

The referenced class library includes SuperMap.IS.ServiceInterface.dll, 

SuperMap.IS.Utility.dll and SuperMap.IS.Weblib.dll. 

Step 4: Display map 

1. Add control 

In the Design view of WebMobile.aspx, right-click Form1 and select Properties. Set 
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the Id of FormID to frmMap. From the Web Mobile From tab of the Toolbox, add the 

Image control to frmMap (Figure 4-31): 

 

Figure 4-31: Add the Image Control 

2. Add code 

Right-click WebMobile.aspx and select View Code. Add the following namespaces to 

the opened WebMobile.aspx.cs file: 

using SuperMap.IS.Web; 

using SuperMap.IS.ServiceInterface; 

using SuperMap.IS.Utility; 

Add the following code to WebMobile.aspx to display a map 

public partial class WebMobile : 

System.Web.UI.MobileControls.MobilePage 

{ 

    //host 

private string m_Address = "localhost";   

// port 

    private int m_Port = 8800;                   

 

    private IMap m_Map; 

 

    protected void Page_Load(object sender, EventArgs e) 

    { 

        if (!Page.IsPostBack) 

        { 



Creating Web Applications                                                          67 

Getting Started with SuperMap IS .NET 

// Creates a map parameter instance 

            MapParam mp = new MapParam();    

            mp.Viewer.LeftTop.X = 0; 

            mp.Viewer.LeftTop.Y = 0; 

            // Sets map image width 

            mp.Viewer.RightBottom.X = this.Device.ScreenPixelsWidth > 

120 ? this.Device.ScreenPixelsWidth : 120;   

            // Sets map image height 

            mp.Viewer.RightBottom.Y = this.Device.ScreenPixelsHeight > 

120 ? this.Device.ScreenPixelsHeight : 120; 

// Name of map to display 

            mp.MapName = "World";  

            // Returns map 

            mp.ReturnImage = true;      

    // Object to describe the map returned by the server 

    MapImage mapImage;      

    //Gets map 

            mapImage = this.Map.GetMapImage(mp);   

            if (mapImage != null) 

            { 

                //Displays returned map in the Image control 

                Image1.ImageUrl = mapImage.MapUrl; 

                // Saves current map state 

                Session["MapParam"] = mapImage.ReturnMapParam;   

            } 

        } 

    } 

    private IMap Map 

    { 

        get 

        { 

            if (m_Map == null) 

            { 
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                m_Map = TcpMap.Create(m_Address, m_Port, new Hashtable()); 

            } 

            return m_Map; 

        } 

    } 

} 

3. Runtime test 

Make sure SuperMap IS .NET map service has been started. Click Debug->Start 

Debugging or press F5 to run the program (Figure 4-32). 

 

Figure 4-32 Debug 

Step 5: Navigate map 

1. Add controls 

Add three Command controls to frmMap. Set the Id of Command1 to 

"cmdViewEntire" and its Text to "View Entire", Id of Command2 to "cmdZoomIn" 

and its Text to "Zoom In", and Id of Command3 to "cmdZoomOut" and its Text to 

"Zoom Out", as in Figure 7: 



Creating Web Applications                                                          69 

Getting Started with SuperMap IS .NET 

 

Figure 4-33: Add Function Buttons 

2. Add code 

Double-click each of the three commands and add the following corresponding code 

to the Click event of each command, respectively: 

    //View Entire 

    protected void cmdViewEntire_Click(object sender, EventArgs e) 

    { 

        MapParam mp = (MapParam)Session["MapParam"]; 

        this.Map.SetCurrentMapParam(mp); 

        MapImage mapImage = this.Map.ViewEntire(String.Empty); 

        if (mapImage != null) 

        { 

            this.Image1.ImageUrl = mapImage.MapUrl; 

            Session["MapParam"] = mapImage.ReturnMapParam; 

        } 

    } 

    //Zoom In 

    protected void cmdZoomIn_Click(object sender, EventArgs e) 

    { 

        MapParam mp = (MapParam)Session["MapParam"]; 

        this.Map.SetCurrentMapParam(mp); 

        MapImage mapImage = this.Map.Zoom(2); 
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        if (mapImage != null) 

        { 

            this.Image1.ImageUrl = mapImage.MapUrl; 

            Session["MapParam"] = mapImage.ReturnMapParam; 

        } 

    } 

    //Zoom Out 

    protected void cmdZoomOut_Click(object sender, EventArgs e) 

    { 

        MapParam mp = (MapParam)Session["MapParam"]; 

        this.Map.SetCurrentMapParam(mp); 

        MapImage mapImage = this.Map.Zoom(0.5); 

        if (mapImage != null) 

        { 

            this.Image1.ImageUrl = mapImage.MapUrl; 

            Session["MapParam"] = mapImage.ReturnMapParam; 

        } 

    } 

3. Runtime test 

Click Debug->Start Debugging or press F5 to run the program. You can click View 

Entire, Zoom In, or Zoom Out to perform the corresponding operation (Figure 4-34): 
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Figure 4-34: Map View 

Step 6: SQL query 

1. Add controls 

Add a TextBox control and a Command control to frmMap. The textbox is used for 

typing SQL expressions in. Set the Id of the newly added command to "cmdSQL" and 

its Text to "Query", as shown in Figure 4-35. 
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Figure 4-35: Add Function Buttons 

2. Add code 

Double-click the Query command and add the following code to the Click event of the 

command: 

protected void cmdSQL_Click(object sender, EventArgs e) 

{ 

    // Creates a new query parameter object 

    QueryParam queryparam = new QueryParam(); 

    if (this.TextBox1.Text != "") 

    { 

        // Uses the expressions typed in the TextBox to query 

        queryparam.WhereClause = this.TextBox1.Text; 

    } 

    else 

    { 

        return; 

    } 
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    // Sets whether to query all the layers of the current map 

    queryparam.IsAllLayer = true; 

    MapParam mp = (MapParam)Session["MapParam"]; 

    this.Map.SetCurrentMapParam(mp); 

    // Sets whether to highlight the query result  

    queryparam.Highlight.HighlightResult = true;  

    // Performs SQL query 

    ResultSet rs = this.Map.QueryBySql(queryparam);  

    if (rs != null && rs.TotalCount > 0) 

    { 

        MapImage mapImage = rs.MapResult; 

        if (mapImage != null) 

        { 

            // Displays the map image returned in the Image control 

            this.Image1.ImageUrl = mapImage.MapUrl;  

            // Saves the current map state 

            Session["MapParam"] = mapImage.ReturnMapParam; 

        } 

   } 

}   

3. Runtime Test 

Click Debug->Start Debugging or press F5 to run the program. You can input a SQL 

expression and click the Query button to perform the SQL query: 
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Figure 4-36: SQL Result 

Step 7: Use Pocket PC emulator to test the application 

1. Create WebMobileDemo virtual directory 

Right-click My Computer and select Manage. In the contents pane on the left of the 

Computer Management dialog, find Services and Applications -> Internet Information 

Services -> Web Sites -> Default Web Site. Right-click Default Web Site and click 

New->Virtual Directory (Figure 4-37). Follow the Virtual Directory Creation Wizard, 

set the directory alias to "WebMobileDemo" and enter the path to the directory that 

contains the contents, in this example, the WebMobileDemo directory created in the 

first step. Click Finish. 
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Figure 4-37: Virtual Directory 

2. Start Pocket PC emulator 

In Visual Studio 2005, click Tools -> Connect to Device. In the Connect to Device 

dialog, select Pocket PC 2003 SE Emulator (Figure 4-38) and click Connect (Figure 

4-39). 
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Figure 4-38: Connect to Pocket PC 2003 SE Emulator Figure 4-39: Pocket PC 2003 

SE Emulator 

3. Configure Pocket PC network adapter 

On Pocket PC 2003, click File -> Configure. In the Emulator Properties dialog box, 

click the Network tab, and check "Enable NE2000 PCMCIA network adapter and bind 

to". Click OK (Figure 4-40). 

 

Figure 4-40: Configure 

Note: You should install the VPC network driver if this message pops up: "Failed to 
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open the VPC Network Driver. Verify that the driver is installed, or install the driver 

from the Web download location at http://go.microsoft.com/fwlink/?linkid=46859". 

4. Configure IP 

On Pocket PC 2003, click Start -> Settings (Figure 4-41). Click the Connections tab at 

the bottom (Figure 4-42) and click the Network Card icon. Select "Work" from the 

"My network card connects to:" dropdowqn list and select NE2000 Compatible 

Ethernet Driver (Figure 4-43). Then select "Use specific IP address" and set the IP 

address that is in the same network segment with that of the server machine (Figure 

4-44). Click the OK icon on the top right. 

  

Figure 4-41: Net Configure Figure 4-42: Connect Configure 
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Figure 4-43: Set Network Card Figure 4-44: Set IP 

5. Set Pocket PC Connections 

Click Start -> Settings, and click the Connections icon. Click the Advanced tab, then 

click "Select Networks" (Figure 4-45). In the Network Management dialog box, select 

My Work Network from the first dropdown list and click the OK icon on the top right 

(Figure 4-46). 

  

Figure 4-45: Pocket PC Connections Pages Figure 4-46: Set Pocket PC Connections 
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6. View WebMobileDemo map 

Click Start -> Internet Explorer and input this address to the address bar: 

http://localhost/WebMobileDemo/WebMobile.Aspx. Click OK to run the WebMobile 

application. You can click the buttons to perform the corresponding map operations. 

4.4 Developing Web applications with 

AjaxControls 

This section gives a demonstration of development with AjaxControl using Microsoft 

Visual Studio 2008 as the development tool and C#.NET as the programming 

language. You can learn the following contents in this chapter: 

 Creating project with SuperMap IS NET templates and displaying maps by 

using MapControl 

 Measuring on the map 

 Finding and selecting features with a Structured Query Language(SQL) 

expression 

Step 1: Creating a new web site project 

1. Launching Visual Studio 2008  

2. Creating a new project 

To create a new web site, click File>New> Web Site, and a New Web Site dialog box 

will pop up. Select SuperMap IS .NET Application Web Site from the Templates 

box and at the bottom of the dialog box, set the Location to be HTTP, and the website 

address to be http://localhost/AjaxControlsDemo, and the Language to be Visual C#. 

Click OK to complete creating a new web site, and the AjaxControlsDemo website 

will be automatically created. Double-click the Default.aspx, and select Design in the 

bottom, you will find that the MapControl and ToolbarControl have been added.  

http://localhost/SMISStepByStepCS
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Step 2: Loading SuperMap IS AjaxControls 

 

Figure 4-47: Loading map 

There are two ways to load controls onto the web page. One is to click Control icon in 

the Toolbox window and drag it to the web page and drop it; the other way is to 

double-click the control icon to load the control automatically onto the page and you 

can change its size and position manually. By using either of the two ways mentioned 

above, MapControl should be loaded first and its Width and Height can be set in the 

Properties window. 

Here the template provided by SuperMap IS .NET is used as the example, the 

MapControl and ToolBar control have been added into the page. The procedure is as 

follows: right-click the MapControl on the homepage and click Load Map, shown as 

Figure 4-47 -①. Types IP address and Port of Map Server in the pop-up MapControl 

Editor dialog box, then the maps published by the Map Server will appear in the 

dropdown map list. Select one of the maps you want to load to the homepage, and 

click the Preview button, and then the map will be displayed below. Click OK and the 

map will be displayed in the MapControl on the homepage as shown in Figure 4-48. 
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Figure 4-48: Basic Map Browse Functions 

Step 3: Measuring on the map 

There are two functions of measuring on the map, which are measuring distance and 

measuring area. 

1. Adds controls 

Drags these two controls (DistaceToolControl, AreaToolControl) to the page from the 

ToolBox. 

2. Addsing code for measuring 

Right-click the project in the Solution Explorer, then select Add/Add New Item, the 

dialog will pop up as Figure 4-49. Select the Jscript File under the Visual Studio 

installed templates and names it as page.js, then click Add.  
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Figure 4-49: Add new item 

3. Adds code into the page.js file as follows:  

function DistanceCompleted(e) 

{ 

   // Displays the result with the unit 

   alert(e.distance+" "+"m"); 

} 

function AreaCompleted(e) 

{ 

   // Displays the result with the unit 

   alert(e.area+"  "+"m*m"); 

} 

Select the source tag of the Default.aspx and add code into the <head> as below, then 

saves the file into the scripts folder of the project.  

<script type=“text/javascript” src=“scripts/page.js”></script> 

4. Event binding  

Right\click the DistanceToolControl  in the Default.aspx page, select Properties 

and then set FinishedEventHandler as DistanceCompleted, the same method is used 

for the AreaToolControl  and set the FinishedEventHandler as AreaCompleted. 
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5. Running test  

Run the program, the result will be displayed in highlight style as shown in Figure 

4-50.  

 

Figure 4-50: The result of measuring 

Step 4: Querying features by SQL 

Querying features by SQL is one of the basic GIS functions. There are two main query 

manners: one is finding and selecting features with a Structured Query Language 

(SQL) expression of attribute fields and the other is querying the related attribute 

information for identified features. In this step, the former one----selecting the features 

by searching with an SQL expression will be introduced. It is a fuzzy query. 

1. Loading controls 

You need to load the following controls (Figure 4-51) onto the webpage which are 
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used to perform the query function. 

Add a TextBox to the web page and set its ID to txtWhereClause in the Properties 

window for inputting.  

Add a Button 1 to the web page and set its ID to btnSQLQuery for submitting the 

query statement, and set the Text property is SQL Query. 

 

Figure 4-51: Add controls on the page 

2. Attaching code for the controls 

Double-click the controls into the HTML mode, and add code for these two controls. 

<input id="txtWhereClause" type="text" style="position:absolute; 

left:630px; top:230px;" /> 

<input id="btnSQLQuery" type="button" value="SQL Query" 

style="position:absolute; left:630px; top:260px;" onclick="SQLQuery()" 

/> 

3.  Attaching code for performance 

Attaching the code into page.js file as below: 
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function SQLQuery() 

{ 

    var qp=new SuperMap.IS.QueryParam(); 

    qp.queryLayers = new Array(); 

    qp.queryLayers[0] = new SuperMap.IS.QueryLayer(); 

    qp.queryLayers[0].layerName = “World_countries@World”; 

//Set the field to return 

qp.queryLayers[0].returnFields = new Array(); 

    qp.queryLayers[0].returnFields[0] = “SmID”; 

    qp.queryLayers[0].returnFields[1] = “Country”; 

    //Access the clause to query 

    qp.queryLayers[0].whereClause=$(“txtWhereClause”).value; 

    //Highlight the result 

    qp.highlight= new SuperMap.IS.Highlight(); 

    qp.highlight.highlightResult = true; 

//SQL Query, and calling the function of onQueryCompleted and 

onQueryError 

rs = 

MapControl1.GetQueryManager().QueryBySql(qp,onQueryCompleted,onQuery

Error); 

} 

function onQueryCompleted(rs) 

{ 

    if(!rs||rs.totalCount<1) 

    { 

        alert(“result is null!”); 

    } 

    else 

    { 

        var str=““; 

        for(var i=0;i<rs.recordsets.length;i++) 

        { 

            for(var j=0;j<rs.recordsets[i].records.length;j++) 
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            { 

                //Converts the result field into string 

                var record=rs.recordsets[i].records[j]; 

                str+=record.fieldValues[0]+”: 

“+record.fieldValues[1]+”\n”; 

            } 

        } 

        //Displays the result in the message box  

        alert(str); 

    } 

} 

function onQueryError() 

{ 

//Displays the error message 

    alert(errorMessage); 

} 

4. Running test 

Type the SmID < 10 to the textbox, then click the SQL Query button, the result will be 

highlight on the map, and the field will return in the message box, as shown in Figure 

4-52. 
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Figure 4-52: The result of query 

 

Step 5: Querying attributes by identifying features 

Identifying features is another way to query geographic database. SuperMap IS .NET 

provides a number of ways to query the attributes of features such as identifying 

features selected by rectangles, polygons, circles or by clicking them on the map.  

1. Loading controls 

You need to load the following controls (Figure 4-53) onto the webpage which are 

used to perform the query function. 
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Figure 4-53: Add controls on the page 

Add a Button 2 to the web page and set its ID to btnPointQuery in the Properties 

window, and set its valuw is PointSelect. 

Add a Button 3 to the web page and set its ID to btnLineQuery in the Properties 

windowg, and set its valuw is LineSelect. 

Add a Button 4 to the web page and set its ID to btnRectQuery in the Properties 

window, and set its valuw is RectSelect. 

Add a Button 5 to the web page and set its ID to btnCircleQuery in the Properties 

window, and set its valuw is CircleSelect. 

Add a Button 6 to the web page and set its ID to btnPolygonQuery in the Properties 

window, and set its valuw is PolygonSelect. 

Add a Button 7 to the web page and set its ID to btnClearHighlight in the Properties 

window, and set its valuw is Clear Highlight. 

2. Adding code for query 

Double-click the Button control into the HTML mpde then add code for these controls 

as below:  
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         <input id="btnPointQuery" type="button" value="Point Select" 

style="position:absolute; left:630px; top:50px;" 

onclick="SetPointQueryAction()" /> 

         <input id="btnLineQuery" type="button" value="Line Select" 

style="position:absolute; left:630px; top:80px;" 

onclick="SetLineQueryAction()" /> 

         <input id="btnRectQuery" type="button" value="Rect Select" 

style="position:absolute; left:630px; top:110px;" 

onclick="SetRectQueryAction()" /> 

         <input id="btnCircleQuery" type="button" value="Circle Select" 

style="position:absolute; left:630px; top:140px;"  

onclick="SetCircleQueryAction()"  /> 

         <input id="btnPolygonQuery"  type="button"  value="Polygon 

Select"  style="position:absolute; left:630px; top:170px;"  

onclick="SetPolygonQueryAction()"  /> 

         <input id="btnClearHighlight"  type="button"  value="Clear 

Highlight"  style="position:absolute; left:630px; top:200px;"  

onclick="ClearHighlight()"  /> 

3. Attaching code for performance 

Attaching the code into the <head> element of the Default.aspx HTML page. 

<script type = "text/javascript" 

src="scripts/SuperMap.IS.Include.js"></script> 

4. Attaching code into the page.js file: 

function SetPointQueryAction() 

{ 

var pointQueryAction = new 

SuperMap.IS.PointQueryAction(["World_countries@World"], 

["SmID","Country"],10,"",onComplete,onError,onStart); 

// Sets the current operation is Point Select 

MapControl1.SetAction(pointQueryAction); 

} 

function SetLineQueryAction() 

{ 

var lineQueryAction = new 

SuperMap.IS.LineQueryAction(["World_countries@World"], 
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["SmID","Country"],"",onComplete,onError,onStart); 

// Set current operation is Line Select 

MapControl1.SetAction(lineQueryAction); 

} 

function SetRectQueryAction() 

{ 

var rectQueryAction = new 

SuperMap.IS.RectQueryAction(["World_countries@World"], 

["SmID","Country"],"",onComplete,onError,onStart); 

//Set the current operation is Rect Select 

MapControl1.SetAction(rectQueryAction); 

} 

function SetCircleQueryAction() 

{ 

var circleQueryAction = new 

SuperMap.IS.CircleQueryAction(["World_countries@World"], 

["SmID","Country"],"",onComplete,onError,onStart); 

//Set the current operation is Circle Query 

MapControl1.SetAction(circleQueryAction); 

} 

function SetPolygonQueryAction() 

{ 

var polygonQueryAction = new 

SuperMap.IS.PolygonQueryAction(["World_countries@World"], 

["SmID","Country"],"",onComplete,onError,onStart); 

//Set the current operation is Polygon Select 

MapControl1.SetAction(polygonQueryAction); 

} 

function ClearHighlight() 

{ 

 // Clear highlight 

MapControl1.ClearHighlight(); 

} 
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function onComplete(result) 

{ 

if(!result||result.totalCount<1) 

{ 

alert("result is null!"); 

} 

else 

{ 

var str=""; 

for(var i=0;i<result.recordsets.length;i++) 

{ 

for(var j=0;j<result.recordsets[i].records.length;j++) 

{ 

 // Convert the result field into string 

var record=result.recordsets[i].records[j]; 

str+=record.fieldValues[0]+": "+record.fieldValues[1]+"\n";                                 

} 

} 

// Displays the result in the message box 

alert(str); 

} 

} 

function onError(errorMessage) 

{ 

 //Displays the error information 

alert(errorMessage); 

} 

function onStart() 

{ 

} 

5. Running test 

Running the program and click the RectSelect in the window, and then query the 
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attributes by dragging a rectangle, the result will be displayed in the message box in 

highlight style, as shown in Figure 4-54.    

 

Figure 4-54: The result of query 

4.5 Developing Web applications with 

AjaxScripts 

The SuperMap IS .NET AjaxScripts is a suit of script library based on ASP .NET Ajax, 

by which developers explore controls with the Ajax-packaged client scripts. 

The AjaxScripts scripts being able to be flexibly developed allow developers to obtain 

substantial and practical service-style GIS websites. Meanwhile, the pages containing 

the DHtml scripts and developed via the AjaxScripts script controls are widely 

supported by the distributed heterogeneous environment.  

Developing with AjaxScripts to create web applications, the browser request is IE 5.0 

or later, Mozilla Firefox 1.0 or later, Netscape 7.1 or later, and Notepad ++ or Editplus 

can be used to code. 

Now the steps how to develop with AjaxScripts is shown as below.  
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Step 1: Preparing the map to publish 

A map which is used to publish should be made before configure and starting service. 

You can use SuperMap Deskpro/SuperMap Express or other desktop software to make 

the data, here the world map under [SuperMap IS .NET Installation directory]\Data is 

used.  

Step 2: Service configuration  

The GIS server and AjaxHandlers should be configured before developing, 

Open GIS server and set the data to be published is [SuperMap IS .NET Installation 

Directory]\Data\SMISSampleDta.smw. 

The next step is to configure the AjaxHandlers. Uses Notepad++ or EditPlus create a 

XML file, and then add code as below. Saves this file with the name of Web.config. 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <!--Sets the Address and the Port of MapServer--> 

  <appSettings> 

    <add key="MapServer_Address" value="localhost" /> 

    <add key="MapServer_Port" value="8800" /> 

  </appSettings> 

  <connectionStrings/> 

  <system.web> 

    <compilation debug="true"/> 

    <authentication mode="Windows"/> 

    <!--HttpHandler mapping of the Request.This Setting is suitable for 

IIS6.--> 

    <httpHandlers> 

      <add verb="*" path="common.ashx" 

type="SuperMap.IS.Ajax.CommonHandler, SuperMap.IS.AjaxLib"/> 

      <add verb="*" path="path.ashx" 

type="SuperMap.IS.Ajax.PathHandler, SuperMap.IS.AjaxLib"/> 
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      <add verb="*" path="map.ashx" type="SuperMap.IS.Ajax.MapHandler, 

SuperMap.IS.AjaxLib"/> 

      <add verb="*" path="edit.ashx" 

type="SuperMap.IS.Ajax.EditHandler, SuperMap.IS.AjaxLib"/> 

      <add verb="*" path="query.ashx" 

type="SuperMap.IS.Ajax.QueryHandler, SuperMap.IS.AjaxLib"/> 

    </httpHandlers> 

  </system.web> 

  <!--HttpHandler mapping of the Request.This Setting is suitable for 

IIS7.--> 

  <system.webServer> 

    <handlers> 

      <add name="common" verb="*" path="common.ashx" 

type="SuperMap.IS.Ajax.CommonHandler, SuperMap.IS.AjaxLib, 

Version=6.0.0.0, Culture=neutral, PublicKeyToken=753ce5cde00ec9b6" 

preCondition="integratedMode" /> 

      <add name="path" verb="*" path="path.ashx" 

type="SuperMap.IS.Ajax.PathHandler, SuperMap.IS.AjaxLib, 

Version=6.0.0.0, Culture=neutral, PublicKeyToken=753ce5cde00ec9b6" 

preCondition="integratedMode" /> 

      <add name="map" verb="*" path="map.ashx" 

type="SuperMap.IS.Ajax.MapHandler, SuperMap.IS.AjaxLib, 

Version=6.0.0.0, Culture=neutral, PublicKeyToken=753ce5cde00ec9b6" 

preCondition="integratedMode" /> 

      <add name="edit" verb="*" path="edit.ashx" 

type="SuperMap.IS.Ajax.EditHandler, SuperMap.IS.AjaxLib, 

Version=6.0.0.0, Culture=neutral, PublicKeyToken=753ce5cde00ec9b6" 

preCondition="integratedMode" /> 

      <add name="query" verb="*" path="query.ashx" 

type="SuperMap.IS.Ajax.QueryHandler, SuperMap.IS.AjaxLib, 

Version=6.0.0.0, Culture=neutral, PublicKeyToken=753ce5cde00ec9b6" 

preCondition="integratedMode" /> 

    </handlers> 

    <validation validateIntegratedModeConfiguration="false" /> 

  </system.webServer> 

</configuration> 
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Step 3: Creating WebSite folder  

Create a folder names AjaxScriptsDemo, the location can be selected by yourself. 

Here put this folder under the [SuperMap IS .NET Installation 

Directory]\Demo\AjaxScriptsDemo. Create virtual directory for this new folder, right 

click this folder, select Properties in the menu, and then select Web sharing tag in the 

dialog, the Properties dialog will pop up as shown in Figure 4-55. Select Sharing this 

folder in the dialog, a new dialog will pop up like Figure 4-56. 

  

Figure 4-55: The folder properties Figure 4-56: Edit alias of the folder 
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Figure 4-57: The folder properties Figure 4-58: Select the method 

Type the inetmgr in the Run dialog to open the IIS Manager, right click the 

AjaxScriptsDemo under the WebSites\Default Web Site, and select Properties in the 

menu, click the Directory Security, the window like Figure 4-57 will pop up. Click 

Edit button on the window to open the Authentication Methods dialog, pitch on the 

Integrated Windows authentication like Figure 4-58. 

Copy the scripts, styles, and images from the [SuperMap IS .NET Installation 

Directory]\WebSDK\AjaxControls to AjaxScriptsDemo, and then copies the 

AjaxControls folder under [SuperMap IS .NET Installation Directory]\WebSDK to 

AjaxScriptsDemo, and renames it as bin. For more resource, copy the images folder 

under [SuperMap IS .NET Installation Directory]\Demo\AjaxDemo to cover the old 

images folder in AjaxScriptsDemo. Put the Web.config you created in the Step 2 into 

the AjaxScriptsDemo folder at last.  

Create a html file names Index.html and saves it into the AjaxScriptsDemo folder.  

Step 4: Creating map window interface 

Attaching code to the Index.html. The utf-8 coding is request, so add the code with 

green color  into  <head> element like below. The title is definiert with AjaxScripts 
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Demo.  

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 

<html xmlns="http://www.w3.org/1999/xhtml"> 

  <head> 

    <meta http-equiv="Content-Type" content="text-html; charset=utf-8" 

/> 

    <title>AjaxScripts Demo</title> 

  </head> 

  <body> 

  </body> 

</html> 

Add the reference of JavaScript file into <head> element. 

<script type="text/javascript" src="scripts/SuperMap.IS.Include.js"> 

Add the MapControl container--<div> block to <body> element, meanwhile, sets 

loading map in the onload event of the body, and unloading the map in the onunload 

event, the code is as below:  

<!--OnPageLoad(), OnPageUnload() are used to implement the parameters 

setting and map loading function--> 

<body onload="OnPageLoad()" onunload="OnPageUnload()"> 

  <!--div sets a map container--> 

  <div id="myMap" style="width: 660px; height: 500px; overflow: hidden; 

margin: 0; padding: 0; position:relative; left: 2px; top: 2px; 

border:solid 1px gray"> 

  </div> 

</body> 

Add the code of OnPageLoad () and OnPageUnload() into <head> element as below: 

  //Defines the MapControl object map 

  var map = null; 

  function OnPageLoad() 
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  { 

    var params = new Object(); 

    //Specifies the address to access the mapHandler 

    params.mapHandler="http://localhost/AjaxScriptsDemo/"   

    // Specifies the name of the map to load 

    params.mapName="World"; 

    // Sets the format of the image to return, it can be png, jpg and gif 

    params.imageFormat="gif"; 

    // Set an instance for MapControl object 

    map = new SuperMap.IS.MapControl($("myMap"), params); 

    map.Init(); 

  } 

  // This method is required when Upload 

  function OnPageUnload() 

  { 

    //Releases the MapControl object 

    map.Destroy(); 

    map= null;  

  } 

Save the file and open the browser (for example, open IE 6), types the address 

http://localhost/AjaxScriptsDemo/Index.html, the running result is as Figure 4-59. 
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Figure 4-59: The running result 

Step 5: Browsing map 

In this step, the function how to implement include: Full Extent, Pan and Zoom. 

Add the code into the <body> element like below: 

<div style="position:relative"> 

  <table> 

    <tr> 

      <td> 

        <img alt="Full Extent" title="viewentire" 

src="images/btn_01_off.gif" onclick="ViewEntire()" /> 

        <img alt="Pan" title="pan" src="images/btn_06_off.gif" 

onclick="SetPanAction()" /> 

        <img alt="QuickZoomIn" title="quickzoomin" 

src="images/btn_ZoomIn.gif" onclick="QuickZoomIn()"> 
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        <img alt="QuickZoomOut" title="quickzoomout" 

src="images/btn_ZoomOut.gif" onclick="QuickZoomOut()"> 

        <img alt="ZoomIn" title="zoom in" src="images/btn_04_off.gif" 

onclick="SetZoomInAction()" /> 

        <img alt="ZoomOut" title="zoom out" src="images/btn_05_off.gif" 

onclick="SetZoomOutAction()" /> 

      </td> 

    </tr> 

  </table> 

</div> 

Add the scripts into the <script> of the <head> element.  

var panAction = null; 

var zoomInAction = null; 

var zoomOutAction = null; 

//Defines the action object of panning and zooming 

 function ViewEntire()  

//Full extent 

{ 

    //Displays the map 

    map.ViewEntire(); 

} 

function QuickZoomIn() 

//Quick zoom in 

{ 

    map.Zoom(2); 

} 

function QuickZoomOut() 

//Quick zoom out 

{ 

 map.Zoom(0.5); 

} 

function SetZoomInAction()  
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//Zoom in 

{ 

    if (!zoomInAction) 

 { 

     //instantiation 

  zoomInAction = new SuperMap.IS.ZoomInAction(); 

 } 

//Set the operation is zoomInAction 

 map.SetAction(zoomInAction); 

} 

function SetZoomOutAction() 

//Zoom out 

{ 

    if (!zoomOutAction) 

 { 

  //instantiation  

  zoomOutAction = new SuperMap.IS.ZoomOutAction(); 

 } 

 //Set the operation is zoomOutAction  

 map.SetAction(zoomOutAction); 

} 

function SetPanAction()  

//Panning 

{ 

    if (!panAction)  

    { 

  //instantiation    

  panAction = new SuperMap.IS.PanAction(); 

 } 

 //Set the operation is panAction 

 map.SetAction(panAction); 

}  
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Type the http://localhost/AjaxScriptsDemo/Index.html into the IE, the result is shown 

as Figure 4-60. 

 

Figure 4-60: The running result 

Step 6: Querying attributes by identifying features 

Identifying features is another way to query geographic database. SuperMap IS .NET 

provides a number of ways to query the attributes of features such as identifying 

features selected by point, rectangles, polygons, circles or by clicking them on the 

map.  

Add the code into the <body> element: 

     <img alt="Point Select" title="queryByPoint" 

src="images/btn_13_off.gif" onclick="SetPointQueryAction()" /> 

     <img alt="Rect Select" title="queryByRect" 

src="images/btn_14_off.gif" onclick="SetRectQueryAction()" /> 

     <img alt="Polygon Select" title="queryByPolygon" 
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src="images/btn_17_off.gif" onclick="SetPolygonQueryAction()" /> 

     <img alt="Circle Select" title="queryByCircle" 

src="images/btn_22_off.gif" onclick="SetCircleQueryAction()" /> 

Add the scripts code into the <script> of the <head> element as below. 

var pointQueryAction = null; 

var rectQueryAction=null; 

var PolygonQueryAction=null; 

var CircleQueryAction=null; 

//Defines the query action object 

function SetPointQueryAction()  

//Point select 

{ 

    if(!pointQueryAction) 

    { 

     pointQueryAction = new 

SuperMap.IS.PointQueryAction(["Capital@World"], ["SmID", "Capital"], 

10,"",onQueryComplete,onQueryError,onQueryStart); 

    

    //Set the operation type is pointQueryAction 

 map.SetAction(pointQueryAction); 

} 

function SetRectQueryAction()  

//Rectangle select 

{ 

    if(!rectQueryAction) 

    { 

     rectQueryAction = new 

SuperMap.IS.RectQueryAction(["Capital@World"], ["SmID","Capital"],"", 

onQueryComplete,onQueryError,onQueryStart); 

 } 

 //Set the operation type is rectQueryAction      

 map.SetAction(rectQueryAction); 

} 



104                                                         Creating Web Applications 

Getting Started with SuperMap IS .NET 

function SetPolygonQueryAction()  

//Polygon query 

{ 

    if(!PolygonQueryAction) 

    { 

     PolygonQueryAction = new 

SuperMap.IS.PolygonQueryAction(["Capital@World"], 

["SmID","Capital"],"", onQueryComplete,onQueryError,onQueryStart); 

  } 

    //Set the operation type is PolygonQueryAction 

 map.SetAction(PolygonQueryAction);  

} 

function SetCircleQueryAction()  

//Circle query 

{ 

    if(!CircleQueryAction) 

    { 

     CircleQueryAction = new 

SuperMap.IS.CircleQueryAction(["Capital@World"], ["SmID", 

"Capital"],"", onQueryComplete,onQueryError,onQueryStart); 

  } 

    //Set the operation type is CircleQueryAction 

    map.SetAction(CircleQueryAction); 

} 

Meanwhile, the code for the function onQueryStart(), onQueryComplete() and 

onQueryComplete() is shown as below: 

var resource_queryError="Error occurs in query"; 

var resource_queryName="The result of query"; 

var resource_queryResultIsNull ="The result of query is null"; 

var resource_query = "Query"; 

function onQueryStart() 

{ 

} 
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function onQueryComplete(resultSet) 

{ 

    var str = "<div 

style='position:absolute;left:0px;top:0px;overflow:auto;width:245px;h

eight:100px'>"; 

    if (!resultSet || resultSet.totalCount < 1) 

{ str="&nbsp;&nbsp;"+resource_queryResultIsNull;} 

    else 

    { 

        for (var i = 0; i < resultSet.recordsets.length; i++)  

        { 

      for (var j = 0; j < resultSet.recordsets[i].records.length; j++)  

        { 

          var record = resultSet.recordsets[i].records[j]; 

       var temp= record.fieldValues[1].replace("'","\\\\\\'"); 

       str+= "<div class=\"query\" onclick=\"" 

            + "if(window.curMapControl.GetZoomLevel()<5){" 

        + "window.curMapControl.SetCenterAndZoom(" 

        + record.center.x + "," + record.center.y + ",5);" 

        + "}else{" 

        + "window.curMapControl.ViewByPoint(" 

        + record.center.x + "," + record.center.y + ");" 

        + "}" 

                    + 

"window.curMapControl.CustomLayer.InsertMark(\'marker\'," 

        + record.center.x + "," + record.center.y + ",10,10,"  

                    + "\'<img src=\\\'images/marker.gif\\\'   

style=\\\'cursor:pointer\\\' 

onmousemove=ShowInfoWindow("+record.center.x+","+record.center.y+",\\

\'"+temp+"\\\') onmouseleave=CloseInfoWindow() /> \');"  

                    + '\">' 

        + record.fieldValues[0] + '&nbsp;&nbsp;' 

        + record.fieldValues[1] + '</div>';     

        str 

        += '<div class="query" onclick="' 
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        + 'window.curMapControl.ViewByPoint(' 

        + record.center.x + ',' + record.center.y + ');' 

        + 

'window.curMapControl.CustomLayer.InsertMark(\'marker\',' 

        + record.center.x + ',' + record.center.y + ',10,10,'  

                    + '\'<img src=\\\'images/marker.gif\\\' alt=\\\'' + 

record.fieldValues[1] + '\\\' style=\\\'cursor:hand\\\' /> \');' 

        + '">' 

        + record.fieldValues[0] + '&nbsp;&nbsp;' 

        + record.fieldValues[1] + '</div>'; 

            } 

        } 

    } 

    str+="</div>"; 

    // Display the result if the win is not null 

    var win=document.getElementById("QueryResult"); 

    if(!win) 

    { 

         

        new 

xWin("QueryResult",10,400,250,122,1,resource_queryName,str); 

    } 

    else 

    { 

        win.childNodes[1].innerHTML = str; 

     this.show(win);    

 } 

} 

function onQueryError(responseText)  

{          

    if(responseText) 

    { 

   alert(resource_queryError+":"+responseText); 
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 } 

 else 

 { 

   alert(resource_queryError+"!"); 

 } 

} 

Define the xwin (the custom windows which is used to display the result): 

var resource_xWinTitle = "Title"; 

var resource_collapse = "Collapse"; 

var resource_hide = "Hidden"; 

var resource_expand = "Expand"; 

function 

xWin(id,left,top,width,height,zIndex,title,content,opacity,color) 

{ 

    if(!left){ left=0; } 

    if(!top){ top=0; } 

    if(!width){ width = 200;} 

    if(!height){height = 200;} 

    if(!zIndex){ zIndex=1; } 

    if(!opacity){ opacity = 0.8;} 

    if(!color){ color = "orange";} 

    if(!title){ title = resource_xWinTitle; } 

    if(!content){content = "";} 

    var headHeight = 15; 

    //Div 

    var win = document.createElement("Div"); 

    win.id = id; 

    win.style.left = left+"px"; 

    win.style.top = top+"px"; 

    win.style.width = width+"px"; 

    win.style.height = height+2+"px"; 

    win.style.position = "absolute"; 
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    win.style.zIndex = zIndex; 

    win.style.filter="alpha(opacity="+opacity*100+")"; 

    win.style.opacity=opacity; 

    document.body.appendChild(win); 

    //head 

    var win_head = document.createElement("Div"); 

    win_head.id = id+"_head"; 

    var imgLeft1 = width-40; 

    var imgLeft2 = width-20; 

    win_head.innerHTML = "<span 

style='position:absolute;cursor:default'>"+title+"</span><span 

style='position:absolute;left:"+imgLeft1+"px;cursor:default'><img 

title="+resource_collapse+" alt="+resource_collapse+" 

style='height:13px;' src='./images/collapse.gif' onclick 

='controlDiv(this.parentNode.parentNode.parentNode)' ></span>  <span 

style='position:absolute;left:"+imgLeft2+"px;cursor:default'><img  

title="+resource_hide+" alt="+resource_hide+" style='height:13px' 

src='./images/hide.gif' 

onclick='hide(this.parentNode.parentNode.parentNode)'> </span>"; 

    win_head.style.left = "0px"; 

    win_head.style.top = "0px"; 

    win_head.style.width = width-4+"px"; 

    win_head.style.height =headHeight+"px"; 

    win_head.style.position = "absolute"; 

    win_head.style.overflow = "hidden"; 

    win_head.style.backgroundColor=color; 

    win_head.style.color="white"; 

    win_head.style.fontSize="14px"; 

    win_head.style.border="2px solid "+color; 

    win_head.style.cursor ="move"; 

    win.appendChild(win_head); 

    //body 

    var win_body = document.createElement("Div"); 

    win_body.id = id+"_body"; 

    win_body.style.left = "0px"; 

    win_body.style.top = headHeight+4+"px"; 
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    win_body.style.width = width-4+"px"; 

    win_body.style.height =height-24+"px"; 

    win_body.style.position = "absolute"; 

    win_body.style.overflow = "hidden"; 

    win_body.style.backgroundColor = "white"; 

    win_body.style.fontSize="12px"; 

    win_body.style.border="2px solid "+color; 

    win_body.innerHTML = content; 

    win.appendChild(win_body); 

} 

//Collapse or expand; 

function controlDiv(obj) 

{ 

    //obj:body 

    var flg = obj.childNodes[1].style.display=="none"; 

    if(flg){ 

        obj.childNodes[1].style.display = "block"; 

        var img = obj.childNodes[0].childNodes[1].childNodes[0]; 

        img.title = resource_collapse; 

        img.alt = resource_collapse; 

        img.src = "./images/collapse.gif"; 

    } 

    else{ 

        obj.childNodes[1].style.display = "none"; 

        var img = obj.childNodes[0].childNodes[1].childNodes[0]; 

        img.title = resource_expand; 

        img.alt = resource_expand; 

        img.src = "./images/expand.gif"; 

    } 

} 

//close; 

function hide(obj) 
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{ 

    //collapse first, then hidden it for the compatibility with Firefox 

    obj.childNodes[1].style.display = "none"; 

    obj.style.visibility = "hidden"; 

} 

//open 

function show(obj) 

{ 

    obj.childNodes[1].style.display = "block"; 

    var img = obj.childNodes[0].childNodes[1].childNodes[0]; 

    img.title = resource_collapse; 

    img.alt = resource_collapse; 

    img.src = "./images/collapse.gif"; 

    obj.style.visibility = "visible"; 

} 

function switchDiv(obj) 

{ 

    if(obj.style.visibility == "hidden"){ 

        //Expand and display 

        obj.childNodes[1].style.display = "block"; 

        var img = obj.childNodes[0].childNodes[1].childNodes[0]; 

        img.title = resource_collapse; 

        img.alt = resource_collapse; 

        img.src = "./images/collapse.gif"; 

        obj.style.visibility = "visible"; 

    }else{ 

   //collapse and hidden 

        obj.childNodes[1].style.display = "none"; 

        var img = obj.childNodes[0].childNodes[1].childNodes[0]; 

        img.title = resource_expand; 

        img.alt = resource_expand; 

        img.src = "./images/expand.gif"; 
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        obj.style.visibility = "hidden"; 

    } 

} 

Type the address http://localhost/AjaxScriptsDemo/Index.html, and the result will 

shown as Figure 4-61. 

 

Figure 4-61: The running result 

Step 7: Measuring on the map 

There are two functions of measuring on the map, which are measuring distance and 

measuring area. 

Attaching code to the <body> element as below: 

   <img alt="Measure Distance" title="measureDistance" 

src="images/btn_15_off.gif" onclick="SetMeasureDistanceAction()" /> 
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   <img alt="Measure Area" title="measureArea" 

src="images/btn_16_off.gif" onclick="SetMeasureAreaAction()" /> 

Add the code into <script> of <head> element as below: 

var measureDistanceAction=null; 

var measureAreaAction=null; 

var resource_measureDistanceLength ="The length is:"; 

var resource_measureResultIsNull = "The result is null."; 

var resource_measureName = "The result of measuring"; 

var resource_measureDistanceError = "Error occurs in measuring 

distance."; 

var resource_measureAreaLength = "The area is:"; 

var resource_maesureAraeError="Error occurs in measuring area."; 

//Defines the action object and string varible 

function SetMeasureDistanceAction()  

//Measure distance 

{ 

    if(!measureDistanceAction) 

    { 

        measureDistanceAction = new 

SuperMap.IS.MeasureDistanceAction(onMeasureDistanceComplete, 

onMeasureDistanceError,onMeasureDistanceStart); 

     } 

    //Set the operation type is measureDistanceAction   

    map.SetAction(measureDistanceAction); 

} 

function SetMeasureAreaAction()  

//Measure area 

{ 

    if(!measureAreaAction) 

    { 

        measureAreaAction = new 

SuperMap.IS.MeasureAreaAction(onMeasureAreaComplete, 

onMeasureAreaError,onMeasureAreaStart); 
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     } 

 //Set the operation type is measureAreaAction 

    map.SetAction(measureAreaAction); 

}  

 

The code for onMeasureDistanceStart(), onMeasureDistanceComplete(), 

onMeasureDistanceError(), onMeasureAreaStart(), onMeasureAreaComplete() and 

onMeasureAreaError(). 

function onMeasureDistanceStart() 

{ 

} 

function onMeasureDistanceComplete(result) 

{ 

    var str=""; 

if(result) 

{ 

        str += "<br><div 

style='font-size:12px'>"+resource_measureDistanceLength+":"+ 

result.distance+"m<br>"; 

} 

Else 

{ 

        str += "<br><div 

style='font-size:12px'>"+resource_measureResultIsNull+"<br>"; 

    } 

    str += "<br><div style='font-size:12px;color:blue;' 

onclick='map.CustomLayer.RemoveLine(\"MeasureDistance\"); 

'>"+resource_clearHighlight+"</div>"; 

    str += "</div><br>"; 

    var win=document.getElementById("MeasureResult"); 

if(!win) 

{ 

        new 
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xWin("MeasureResult",420,10,250,100,1,resource_measureName,str); 

 } 

 else 

 { 

        win.childNodes[1].innerHTML = str; 

        this.show(win); 

    } 

} 

function onMeasureDistanceError(responseText)  

{ 

    alert(resource_measureDistanceError+":"+reponseText); 

} 

function onMeasureAreaStart() 

{ 

} 

function onMeasureAreaComplete(result) 

{ 

    var str=""; 

if(result) 

{ 

        str += "<br><div 

style='font-size:12px'>"+resource_measureAreaLength+":"+result.area+ 

"m*m<br>";} 

else 

{ 

        str +=  "<br><div 

style='font-size:12px'>"+resource_measureResultIsNull+"<br>"; 

    } 

    str += "<br><div style='font-size:12px;color:blue;' 

onclick='map.CustomLayer.RemovePolygon(\"MeasureArea\"); 

'>"+resource_clearHighlight+"</div>"; 

    str += "</div><br>"; 

    var win=document.getElementById("MeasureResult"); 

if(!win) 
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{ 

        new 

xWin("MeasureResult",420,10,250,100,1,resource_measureName,str); 

    } 

 else 

 { 

        win.childNodes[1].innerHTML = str; 

     this.show(win); 

 } 

} 

function onMeasureAreaError(responseText)  

{      

if(responseText) 

{ 

alert(resource_maesureAraeError+":"+reponseText); 

} 

else 

{ 

alert(resource_maesureAraeError+"!"); 

} 

} 

Type the http://localhost/AjaxScriptsDemo/Index.html into the IE, the result is shown 

as Figure 4-62. 
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Figure 4-62: The running result 

Step 8: Adding Overview control 

The positon and extent of the map displayed in the current window can be get through 

the overview contrl, and the map information can be changed when moving the red 

pane in the overview control. 

Add the code into <body> element as below:  

<img alt="Overview" title="overview" src="images/btn_34_off.gif" 

onclick="SwitchOverview()" /> 

And then add the code into the <script> of the <head> element as below:  

var overview=null; 

function SwitchOverview() 

{ 
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    var overview = document.getElementById("overview"); 

    this.switchDiv(overview); 

} 

Modify the code in the OnPageLoad() in order to add the overview control when 

loading page: 

map = new SuperMap.IS.MapControl($("myMap"), params); 

var overviewParams = new Object(); 

new xWin("overview",10,15,200,200,1,"Overview",""); 

$("overview").style.zIndex=1; 

overview = new 

SuperMap.IS.OverviewControl($("overview_body"),map,overviewParams); 

map.Init(); 

Type the http://localhost/AjaxScriptsDemo/Index.html into the IE, the result is shown 

as Figure 4-63. 

 

Figure 4-63: The running result 
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Step 9: Implementing the highlight function 

This function is used to clear the highlight style on the map.  

Attaching the below code into the <body> element.  

<img alt="Clear highlight" title="clearhighlight" 

src="images/btn_11_off.gif" onclick="ClearHighLight()" /> 

Add the event handler into <script> of the <head> element like below:  

function ClearHighLight() 

{ 

    map.ClearHighlight(); 

} 

Type the http://localhost/AjaxScriptsDemo/Index.html into the IE, the result is shown as 

Figure 4-64.  

 

Figure 4-64: The running result 

 

http://localhost/AjaxScriptsDemo/Index.html
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4.6 Developing Web applications with 

WebService 

This section will introduce how to develop GIS application using SuperMap IS 

WebService. Follow the procedures in this section, you can build a simple publication 

system to display, browse, and query spatial and attribute data, etc. in short order.  

This section gives a demonstration using Microsoft Visual Studio 2008 as the 

development tool and C#.NET as the programming language and you can learn the 

following contents from this section: 

 How to use WebService 

 Displaying maps by using WebService 

 Navigating on the map with the frequently used tools: Zoom In/Out and Pan, 

etc. 

 Finding and selecting features with a Structured Query Language (SQL) 

expression 

Before developing with SuperMap IS WebService, the operations of configuring 

development environment, creating a map, and starting map service are also needed, 

which will go all the way with the development with WebControl. You can go back to 

review these contents in the previous chapters. 

Step 1: Creating a new web site project 

Microsoft Visual Studio 2008 is used as the development environment which supports 

many different programming languages.You can create various types of ASP.NET Web 

Application. Here a Visual C# Web Application will be created. Start Visual Studio 

2005 development environment. In the Visual Studio 2008 user interface, click File > 

New > Project, and a New Project dialogue box will pop up as shown in Figure 4-65. 

Select ASP.NET Web Site from the above Templates box. At the bottom of the 

dialogue box, set the Location to be HTTP, the website address to be 
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http://localhost/WebServiceDemo, and set the Language to be Visual C#. 

 

Figure 4-65: Creating a New Web Site 

Click OK to complete creating a new web site, and the WebServiceDemo website will 

be automatically created. 

Step 2: Adding SuperMap IS WebService reference 

To implement GIS functionality with SuperMap IS WebService, the address of 

WebService which will provides the map service by typing the address in Web 

Reference should be specified first. Usually, the server will provide SuperMap IS 

WebService service after SuperMap IS .NET is installed, and the service is accessible 

in the WebServices directory. You just need to start the map service of SuperMap 

IS .NET should be started only. The following procedure is to add SuperMap IS 

WebService address.  

Select the project in Solution Explorer window, right-click and click Add Web 

Reference...in the shortcut menu, as shown in Figure 4-66. 

http://localhost/WebServiceDemo
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Figure 4-66: Adding 

WebService Address 

Figure 4-67: Adding Web Reference 

The Add Web Reference dialog box will pop up, as shown in Figure 4-67. Type the 

address of SuperMap IS WebService as the URL address (Figure 4-67-(1)), and the 

format is usually as follows: http://webservice's IP/IS/WebServices/EditService.asmx. 

In this demo, the WebService is provided by local host, so the URL address is: 

http://Localhost/IS/WebServices/EditService.asmx. Then click Go, and the found 

services will be listed in the Web service found at this URL list box. Type the Web 

reference name, and in this demo, EditService (Figure 4-67-(2)) has been set. Click 

the Add Reference button (Figure 4-67-(3)) to complete the adding of SuperMap IS 

WebService. 

Step 3: Loading map display controls 

A default.aspx web page was created when creating a new project. Double-click 

default.aspx in Solution Explore window to open this web page. Load an Image 

control to the page, and set the Height of the control to 500, and Width to 600. The 

procedure is as follows: 

Open the default.aspx web page, and click the Source tab at the bottom of the page, as 

shown in Figure 4-68-(1)(2), then the source code of the page will appear, where you 

can add the Image control and set its size, as shown in Figure 4-68-(3). The code is as 
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follows: 

<div> 

 <asp:Image ID="Image1" runat="server" Height="500px" Width="600px" />; 

</div> 

 

Figure 4-68: Loading Map Display Control 

Step 4: Displaying a map  

The main function to be implemented in this step is: When loading the page, the map 

will be displayed. Click the Design tab at the bottom of Default.aspx page, and the 

Default.aspx design page will appear. Double-click the blank of the page to navigate 

to the page_load event of Default.aspx, and the map display function will be 

implemented in this event. The code is as follows: 

public partial class _Default : System.Web.UI.Page  

{ 

    //Set a EditService instance 

    EditService.EditService editservice = new EditService.EditService(); 

    protected void Page_Load(object sender, EventArgs e) 

    { 

        if (!Page.IsPostBack) 
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        { 

            //Set the MapParam instance. 

            EditService.MapParam mp = new EditService.MapParam(); 

            //Set map viewer 

            mp.Viewer = new EditService.PixelRect(); 

            mp.Viewer.LeftTop = new EditService.PixelCoord(); 

            mp.Viewer.RightBottom = new EditService.PixelCoord(); 

            //Set the size of the map. 

            mp.Viewer.LeftTop.X = 0; 

            mp.Viewer.LeftTop.Y = 0; 

            //Set the width of map to that of Image control. 

            mp.Viewer.RightBottom.X = (int)this.Image1.Width.Value; 

            mp.Viewer.RightBottom.Y = (int)this.Image1.Height.Value; 

            //Obtain map list provided by current EditService. 

            string[] mapNames = editservice.GetMapList(); 

            if (mapNames.Length > 0) 

            { 

                //Set to Display the second map. 

                mp.MapName = mapNames[1]; 

            } 

            else 

            { 

                return; 

            } 

            // Set to return the required map. 

            mp.ReturnImage = true; 

            //Set the map description object to describe return result.    

            EditService.MapImage mapImage; 

            //Obtain map. 

            mapImage = editservice.GetMapImage(mp); 

 

            if (mapImage != null) 
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            { 

                //Set to display the return map to the Image control. 

                this.Image1.ImageUrl = mapImage.MapUrl; 

                //Save the status of current map. 

                Session["MapParam"] = mapImage.ReturnMapParam; 

 

            } 

        } 

 

    } 

} 

Step 5: Implementing map browse functionality 

Open the Default.aspx web page, and click the Design tab at the bottom of it to enter 

into the Default.aspx design page. Add three Buttons to the page, and set Name of 

them respectively to btnViewEntire—to zoom to the full extent of the map, 

btnZoomIn—to zoom in the map, btnZoomOut—to zoom out the map, as shown in 

Figure 4-69. 

 

Figure 4-69: The Runtime Result 

1. Zooming to the full extent of the map 
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Double-click the btnViewEntire button in Default.aspx design page to navigate to the 

Click event of this button, and add the following code to the event to implement the 

function of zooming to the full extent of the map. 

    protected void btnViewEntire_Click(object sender, EventArgs e) 

    { 

        //Obtain the parameters of current map. 

        EditService.MapParam mp = 

(EditService.MapParam)Session["MapParam"]; 

        //Display the map with ViewEntire method.                                  

        EditService.MapImage mapImage = 

editservice.ViewEntire(mp.MapName, string.Empty, 

(int)this.Image1.Width.Value, (int)this.Image1.Height.Value); 

 

        if (mapImage != null) 

        { 

            //Display the returned map in the Image control. 

            this.Image1.ImageUrl = mapImage.MapUrl; 

            //Save the status of current map. 

            Session["MapParam"] = mapImage.ReturnMapParam; 

        } 

    } 

2. Zooming in 

Double-click the btnZoomIn button in Default.aspx design page to navigate to the 

Click event of this button, and add the following code to the event to implement the 

function of zooming in the map.  

    protected void btnZoomIn_Click(object sender, EventArgs e) 

    { 

        //Obtain the parameters of current map. 

        EditService.MapParam mp = 

(EditService.MapParam)Session["MapParam"]; 

        //Set the Center of the current map obtained for the center of the 

map coordinates. 
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        EditService.MapCoord center = mp.Center; 

        //Display the map with the Zoom method. 

        EditService.MapImage mapImage = editservice.Zoom(center, 2, mp); 

 

        if (mapImage != null) 

        { 

            //Display the return map in the Image control. 

            this.Image1.ImageUrl = mapImage.MapUrl; 

            //Save the status of current map. 

            Session["MapParam"] = mapImage.ReturnMapParam; 

        } 

    } 

3. Zooming out 

Double-click the btnZoomOut button in Default.aspx design page to navigate to the 

Click event of this button, and add the following code to the event to implement the 

function of zooming out the map.  

    protected void btnZoomOut_Click(object sender, EventArgs e) 

    { 

        //Obtain the parameters of current map. 

        EditService.MapParam mp = 

(EditService.MapParam)Session["MapParam"]; 

        //Set the Center of the current map obtained for the center of the 

map coordinates. 

        EditService.MapCoord center = mp.Center; 

        //Display the map with the Zoom method. 

        EditService.MapImage mapImage = editservice.Zoom(center, 0.5, 

mp); 

 

        if (mapImage != null) 

        { 

            //Display the return map in the Image control. 

            this.Image1.ImageUrl = mapImage.MapUrl; 
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            //Save the status of current map. 

            Session["MapParam"] = mapImage.ReturnMapParam; 

        } 

    } 

Step 6: Querying features by SQL 

1. Adding controls 

Open the Default.aspx web page, and click the Design tab at the bottom of it to enter 

into the Default.aspx design page. Add a Button to the page, and set its Name to 

btnSQL. Add a TextBox for typing query condition sentences, as shown in Figure 

4-70. 

 

Figure 4-70: Adding Controls 

2. Adding code 

Double-click the btnSQL button in Default.aspx design page to navigate to the Click 

event of this button, and add the following code to the event to implement the function 
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of querying by SQL. 

    protected void btnSQL_Click(object sender, EventArgs e) 

    { 

        // Set an instance of QueryParam.  

        EditService.QueryParam queryparam = new 

EditService.QueryParam(); 

        if (this.TextBox1.Text != "") 

        { 

            // Set the query condition to the condition sentence in the 

TextBox 

            queryparam.WhereClause = this.TextBox1.Text; 

        } 

        else 

        { 

            return; 

        } 

        //Set whether to query all the layers of current map or not 

        queryparam.IsAllLayer = true; 

        //Obtain the parameter information of current map        

        EditService.MapParam mp = 

(EditService.MapParam)Session["MapParam"]; 

        //Set an instance of hightlight object      

        queryparam.Highlight = new EditService.Highlight(); 

        //Set whether to hightlight the query result on the map  

        queryparam.Highlight.HighlightResult = true; 

        //set an instance of return fields 

        queryparam.ReturnFields = new string[2]; 

        //Set the return fields 

        queryparam.ReturnFields[0] = "SmId"; 

        queryparam.ReturnFields[1] = "SmUserId"; 

        //Perform SQL querying 

        EditService.ResultSet rs = editservice.QuerySql(queryparam, mp); 
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        if (rs != null && rs.TotalCount > 0) 

        { 

            EditService.MapImage mapImage = rs.MapResult; 

            if (mapImage != null) 

            { 

                //Display the return map in the Image control 

                this.Image1.ImageUrl = mapImage.MapUrl; 

                //Save the status of current map 

                Session["MapParam"] = mapImage.ReturnMapParam; 

 

            } 

            //If no Results return, display the geometry records in a new 

window. 

            ShowQueryResult(rs); 

        } 

    } 

 

    private void ShowQueryResult(EditService.ResultSet resultSet) 

    { 

        if (resultSet == null || resultSet.Recordsets == null   || 

resultSet.Recordsets.Length <= 0) 

        { 

            return; 

        } 

        int tableCount = resultSet.Recordsets.Length; 

        string strQueryResult = ""; 

        for (int i = 0; i < tableCount; i++) 

        { 

            EditService.Recordset curRecordset = 

resultSet.Recordsets[i]; 

            strQueryResult += "<table style=\"font-size: 9pt\" border=1pt 

bordercolorlight=#C0C0C0 cellspacing=1pt bordercolordark=#FFFFFF 

bgcolor=#ceccc1 width=100%><tr>"; 

            int headerCount = curRecordset.ReturnFields.Length; 
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            for (int j = 0; j < headerCount; j++) 

            { 

                strQueryResult += string.Format("<td>{0}</td>", 

curRecordset.ReturnFields[j]); 

            } 

            strQueryResult += "</tr>"; 

            int recordCount = curRecordset.Records.Length; 

            for (int j = 0; j < recordCount; j++) 

            { 

                EditService.Record curRecord = curRecordset.Records[j]; 

                int valueCount = curRecord.FieldValues.Length; 

                strQueryResult += "<tr>"; 

                for (int k = 0; k < valueCount; k++) 

                { 

                    strQueryResult += string.Format("<td>{0}</td>", 

curRecord.FieldValues[k]); 

                } 

                strQueryResult += "</tr>"; 

            } 

            strQueryResult += "</table>"; 

        } 

        string jsResult = "<script language='javascript'>"; 

        jsResult += "var strTable = '" + strQueryResult + "';"; 

        jsResult += "var 

strFeature='status=no,toolbar=no,resizable=no,menubar=no,location 

=no,scrollbars=yes';"; 

        jsResult += "var aWin = 

window.open('','QueryResult',strFeature);"; 

        jsResult += "aWin.document.open();"; 

        jsResult += "aWin.document.write(\"<html>\");"; 

        jsResult += "aWin.document.write(\"<head>\");"; 

        jsResult += "aWin.document.write(\"<meta 

http-equiv='Content-Type' content='text/html; charset=gb2312'>\");"; 

        jsResult += "aWin.document.write(\"<title>SuperMap IS Query 

Result</title>\");"; 
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        jsResult += "aWin.document.write(\"</head>\");"; 

        jsResult += "aWin.document.write(\"<BODY style='font-size: 9pt' 

bgcolor=#eeccE1>\");"; 

        jsResult += "aWin.document.write(strTable);"; 

        jsResult += "aWin.document.write(\"</BODY>\");"; 

        jsResult += "aWin.document.write(\"</html>\");"; 

        jsResult += "aWin.document.close();"; 

        jsResult += "aWin.focus();"; 

        jsResult += "</script>"; 

        if (!Page.IsClientScriptBlockRegistered("jsResult")) 

        { 

            Page.RegisterClientScriptBlock("jsResult", jsResult); 

        } 

    }  

3. Runtime Test 

Make sure that SuperMap IS .NET map service has been started successfully before 

running the program. 

Select the Start Debugging in the Debug menu or click on the toolbar 

or press F5 key to run the program. Type the query condition in the text box, as shown 

in Figure 4-71-(1), then click the Query button. The returned result will be displayed 

on a new web page, and the features satisfying the query will be highlighted on the 

map, as shown in Figure 4-71-(2), and the properties of the result is shown in Figure 

4-71-(3).  
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Figure 4-71: The Runtime Result 

4.7 Developing Web applications with Web 

Components Libraries 

This section will introduce how to create web application using web components 

libraries. This section gives three demonstrations and you can learn the following 

contents from this section: 

 Publishing and using OGC service(use WMS service as example) 

 Publishing and using KML service 

 Publishing and using GeoRSS service 

Note: You can find the web components libraries mentioned in this section is located 

in<SuperMap IS .NET Installation Directory>\WebServices.  
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4.7.1 Publishing and using WMS services   

Step 1: Creating a new web site folder 

Create in [SuperMap IS .NET Installation Directory]\Demo a new folder named 

SuperMapWMS for the service to be published, then copy the "bin" and "images" 

folder in [SuperMap IS .NET Installation Directory]\WebServices to the new 

SuperMapWMS folder. Then new creates two folders with names "descriptions" and 

"schemas" in folder SuperMapWMS. Copy the "wms" folder in [SuperMap IS .NET 

Installation Directory] \WebServices\schemas to new "schemas" folder. 

Create the virtual directory for SuperMapWMS folder, the details please refer to the 

chapter 5.     

Step 2: Creating a description file of WMS service 

The description file is used to describe the information of WMS service, it is 

organized according to the OGC criterion, for details please refer to the related 

criterion about OGC. 

 Launching Visual Studio 2008. 

 Click File>New>File, then select XML files in the Template window, as 

shown in Figure 4-72. 
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Figure 4-72: New a XML file 

 Add the following code to the XML file:  

<?xml version="1.0" encoding="UTF-8"?> 

<Service> 

  <Name>OGC:WMS</Name> 

  <!-- Human-readable title for pick lists --> 

  <Title>SuperMap Corp. Map Service</Title> 

  <!-- Narrative description providing additional information --> 

  <Abstract> 

    WMT Map Server maintained by SuperMap Corporation. Contact: 

    support@supermap.com. High-quality maps. 

  </Abstract> 

  <KeywordList> 

    <Keyword>world</Keyword> 

  </KeywordList> 

  <!-- Top-level web address of service or service provider. --> 

  <OnlineResource xmlns:xlink="http://www.w3.org/1999/xlink" 

xlink:type="simple" 

  xlink:href="http://www.supermap.com" /> 

  <!-- Contact information --> 

  <ContactInformation> 

    <ContactPersonPrimary> 
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      <ContactPerson>SuperMap Inc</ContactPerson> 

      <ContactOrganization>SuperMap Inc</ContactOrganization> 

    </ContactPersonPrimary> 

    <ContactPosition>SuperMap Inc</ContactPosition> 

    <ContactAddress> 

      <AddressType>postal</AddressType> 

      <Address>3/F Tower B, Taiwei Scientific-research Building, No.31, 

JiancaiChengWest Road, Xisanqi Block Haidian District, Beijing 100096, 

China</Address> 

      <City>Beijing</City> 

      <StateOrProvince>Beijing</StateOrProvince> 

      <PostCode>100096</PostCode> 

      <Country>China</Country> 

    </ContactAddress> 

    <ContactVoiceTelephone>+86-10-82938424</ContactVoiceTelephone> 

    

<ContactFacsimileTelephone>+86-10-82938424</ContactFacsimileTelephone

> 

    

<ContactElectronicMailAddress>support@supermap.com</ContactElectronic

MailAddress> 

  </ContactInformation> 

  <!-- Fees or access constraints imposed. --> 

  <Fees>none</Fees> 

  <AccessConstraints>none</AccessConstraints> 

</Service> 

Save this file in UTF-8 format and names it as wms_description.xml to the [SuperMap 

IS .NET Installation Directory]\Demo\SuperMapWMS\descriptions. This file includes 

the service name, service title, key words, the information about service publisher and 

etc. 

Step 3: Configuring the Web.config file 

Web.config is the core file for publishing service, it includes the service name, the 

address and port of service to access, the data access protocol that supported, the 
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HttpHandler mapped, service description and etc. 

 Launching Visual Studio 2008 

 Click File>New>File, select Web node in the left window, then select Web 

configuration file in the Template window as shown in Figure 4-73. 

 

Figure 4-73: New a configuration file 

 Add the following code to the web configuration file:  

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <!--Describes the services types in <SuperMap.Web>.--> 

    <sectionGroup name="SuperMap.Web" 

type="SuperMap.IS.Configuration.RootSectionGroup"> 

      <section name="wms" type="SuperMap.IS.Configuration.WmsSection" 

/> 

    </sectionGroup> 

  </configSections> 

  <!--The address and port number of WebServices to publish.--> 

  <appSettings> 

    <add key="AppServer" value="127.0.0.1" /> 

    <add key="AppPort" value="8800" /> 

  </appSettings> 
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  <connectionStrings /> 

  <system.web> 

    <compilation debug="true"> 

      <assemblies> 

        <add assembly="System.Design, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=B03F5F7F11D50A3A" /> 

        <add assembly="System.Windows.Forms, Version=2.0.0.0, 

Culture=neutral, PublicKeyToken=B77A5C561934E089" /> 

        <add assembly="System.Runtime.Serialization.Formatters.Soap, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=B03F5F7F11D50A3A" /> 

      </assemblies> 

    </compilation> 

    <!--The httpHandler mapping of the service request. The Settings apply 

for IIS 6.--> 

    <httpHandlers> 

      <add verb="*" path="wms.ashx" 

type="SuperMap.IS.WebServices.WmsHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="wms_changchun.ashx" 

type="SuperMap.IS.WebServices.WmsHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="wms_world.ashx" 

type="SuperMap.IS.WebServices.WmsHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="ImageHandler.ashx" 

type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" /> 

    </httpHandlers> 

  </system.web> 

  <!--Configuration web service declaration area.--> 

  <SuperMap.Web> 

    <!--WMS service configuration node.--> 

    <wms> 

      <!--WMS service.--> 

      <wmsServices> 

        <!--Describes the communication manner and address of different 

request,version of the service, map to publish and the descripation 

information.--> 

        <wmsService handlerPath="wms.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="1.1.1" 

publishedMapName="" descriptionConfig="dsConfig1" 
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useDefaultVisibilitiesOfMap="true" /> 

        <wmsService handlerPath="wms_changchun.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="1.1.1" 

publishedMapName="changchun" simulatePlaneSRSAsLatLon="true" 

simulateLatLonBBox="" descriptionConfig="dsConfig1" /> 

        <wmsService handlerPath="wms_world.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="1.1.1" 

publishedMapName="World" descriptionConfig="dsConfig1" /> 

      </wmsServices> 

      <!--The configuration of description information.--> 

      <wmsDescriptions> 

        <wmsDescription name="dsConfig1" 

source="descriptions\wms_description.xml" /> 

        <wmsDescription name="dsConfig2" source="" /> 

      </wmsDescriptions> 

    </wms> 

  </SuperMap.Web> 

  <!--The httpHandler mapping of the service request. The Settings apply 

for IIS 7.--> 

  <system.webServer> 

    <handlers> 

      <add name="ImageHandler.ashx_*" path="ImageHandler.ashx" verb="*" 

type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="wms_world.ashx_*" path="wms_world.ashx" verb="*" 

type="SuperMap.IS.WebServices.WmsHandler, SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="wms_changchun.ashx_*" path="wms_changchun.ashx" 

verb="*" type="SuperMap.IS.WebServices.WmsHandler, 

SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="wms.ashx_*" path="wms.ashx" verb="*" 

type="SuperMap.IS.WebServices.WmsHandler, SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

    </handlers> 

    <validation validateIntegratedModeConfiguration="false" /> 

  </system.webServer> 

</configuration>  
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Saves this file in UTF-8 format to [SuperMap IS .NET Installation 

Directory]\Demo\SuperMapWMS folder, and names it as Web.config. 

Step 4: Using WMS service 

 Start map service. 

 Type the 

http://localhost/SuperMapWMS/wms.ashx?map=World&SERVICE=WMS&REQUES

T=GetCapabilities&VERSION=1.1.1 in the browser to complete the operation of 

GetCapabilities, for example in the IE. The result is shownas in Figure 4-74.  

 

Figure 4-74: The GetCapabilities operation 

 After the GetCapabilities operation users can obtain the metadata in service 

level that describes the contents and parameters about the service. For example SRS 

(Spatial Reference System), its returns have many, users can select one of them. Type 

the 

http://localhost/SuperMapWMS/wms.ashx?map=World&SERVICE=WMS&REQUES

T=GetMap&LAYERS=&STYLES=&SRS=EPSG:4214&BBOX=178.509643497235

43,-0.00081174562830742529,178.51286873648985,0.00081174562830742529&WI

DTH=1000&HEIGHT=600&FORMAT=image/gif&BGCOLOR=&VERSION=1.1.1 

in the browser to complete the operation of GetMap, thereinto "EPSG:4214" is the 

code of Reference System. The result is shown in the IE as in Figure 4-75. 
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Figure 4-75: The GetMap operation  

 Type the 

http://localhost/SuperMapWMS/wms.ashx?map=World&SERVICE=WMS%20&REQ

UEST=GetFeatureInfo&LAYERS=World@world&SRS=EPSG:4326&BBOX=-3,44,

10,53&WIDTH=600&HEIGHT=350&QUERY_LAYERS=World@world&INFO_FO

RMAT=application/vnd.ogc.wms_xml&I=40&J=10&VERSION=1.1.1 in the browser 

to complete the operation of GetMap, for example in the IE. The result isshown as in 

Figure 4-76.  
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Figure 4-76: GetMap operation 

4.7.2 Publishing and using WFS service 

Step 1: Creating a new web site folder 

Create a new web site folder named SuperMapWFS for the service to be published 

located in [SuperMap IS .NET Installation Directory]\Demo, then copies the folders of 

bin and images under [SuperMap IS .NET Installation Directory]\WebServices to this 

new SuperMapWFS folder and new a folder names descriptions under the 

SuperMapWMS folder. 

Create the virtual directory for SuperMapWFS folder, the details please refer to the 

chapter 5.     

Step 2: Creating a description file of WFS service 

The description file is used to describe the information of WMS service, it is 

organized according to the OGC criterion, for details please refer to the related 

criterion about OGC. 

 Launching Visual Studio 2008. 
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 Click File>New>File, then select XML files in the Template window. 

 Add the following code to the XML file: 

<?xml version="1.0" encoding="UTF-8"?> 

<Service xmlns="http://www.opengis.net/wfs"> 

  <!-- The WMT-defined name for this type of service --> 

  <Name>WFS</Name> 

  <!-- Human-readable title for pick lists --> 

  <Title>SuperMap Corp. Feature Service</Title> 

  <!-- Narrative description providing additional information --> 

  <Abstract> 

    Web Feature Server maintained by SuperMap Corporation. Contact 

    support@supermap.com. High-quality maps. 

  </Abstract> 

  <Keywords>world</Keywords> 

  <!-- Top-level web address of service or service provider. --> 

  

<OnlineResource>http://localhost/ISWebServices/wfs_world.ashx</Onli

neResource> 

  <Fees>NONE</Fees> 

  <AccessConstraints>NONE</AccessConstraints> 

</Service> 

Save this file in UTF-8 format and names it as wfs_description.xml to the [SuperMap 

IS .NET Installation Directory]\Demo\SuperMapWFS\descriptions. This file includes 

the service name, service title, key words, the information about service publisher and 

etc. 

Step 3: Configuring the Web.config file 

Web.config is the core file for publishing service, it includes the service name, the 

address and port of service to access, the data access protocol that supported, the 

HttpHandler mapped, service description and etc.. 

 Launching Visual Studio 2008. 
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 Click File>New>File, then select XML files in the Template window. 

 Add the following code to the web configuration file:  

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <!--Describes the services types in <SuperMap.Web>--> 

    <sectionGroup name="SuperMap.Web" 

type="SuperMap.IS.Configuration.RootSectionGroup"> 

      <section name="wfs" type="SuperMap.IS.Configuration.WfsSection" 

/> 

    </sectionGroup> 

  </configSections> 

  <appSettings> 

    <add key="AppServer" value="127.0.0.1" /> 

    <add key="AppPort" value="8800" /> 

  </appSettings> 

  <connectionStrings /> 

  <system.web> 

    <compilation debug="true"> 

      <assemblies> 

        <add assembly="System.Design, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=B03F5F7F11D50A3A" /> 

        <add assembly="System.Windows.Forms, Version=2.0.0.0, 

Culture=neutral, PublicKeyToken=B77A5C561934E089" /> 

        <add assembly="System.Runtime.Serialization.Formatters.Soap, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=B03F5F7F11D50A3A" /> 

      </assemblies> 

    </compilation> 

    <authentication mode="Windows" /> 

    <!--The httpHandler mapping of each service request. The settings 

apply for IIS 6.--> 

    <httpHandlers> 

      <add verb="*" path="wfs.ashx" 
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type="SuperMap.IS.WebServices.WfsHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="wfs_changchun.ashx" 

type="SuperMap.IS.WebServices.WfsHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="wfs_world.ashx" 

type="SuperMap.IS.WebServices.WfsHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="ImageHandler.ashx" 

type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" /> 

    </httpHandlers> 

  </system.web> 

  <SuperMap.Web> 

    <!--WFS service configuration node--> 

    <wfs> 

      <!--WFS service--> 

      <wfsServices> 

        <!--Describes the communication manner and address of different 

request,version of the service, map to publish and the descripation 

information--> 

        <wfsService handlerPath="wfs.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" 

defaultVersion="1.0.0" publishedMapName="" 

descriptionConfig="dsConfig1"> 

          <!--The Server buildes automatic xml namespace and gml feature 

type for every datasource，dataset. --> 

          <featureTypeNamespaces> 

            <add key="world" value="http://www.supermap.com/data/world" 

/> 

          </featureTypeNamespaces> 

          <datasetFeatureTypes> 

            <add key="Capital@world" value="world:Capital" /> 

          </datasetFeatureTypes> 

          <!--The Server makes mapping automatic with gml for the returned 

fields of the datasets.--> 

          <dataPropertyNames> 

            <add key=":{bounds}" value="gml:boundedBy" /> 

            <add key=":{geometry}" value="gml:{geometryProperty}" /> 

            <add key=":gml_name" value="gml:name" /> 
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            <add key=":gml_description" value="gml:description" /> 

          </dataPropertyNames> 

          <dataPropertyOrders> 

            <!--The default order: firstly, the property infos of gml 

namespace; then, the ordered fields of the datasets, finally, the spatial 

infos.--> 

            <add key="Capital@world" value="gml:description, gml:name, 

gml:boundedBy, Country, Capital, Cap_Pop, gml:{geometryProperty}" /> 

          </dataPropertyOrders> 

        </wfsService> 

        <wfsService handlerPath="wfs_changchun.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" 

defaultVersion="1.0.0" publishedMapName="changchun" 

simulatePlaneSRSAsLatLon="true" simulateLatLonBBox="" 

descriptionConfig="dsConfig1" /> 

        <wfsService handlerPath="wfs_world.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" 

defaultVersion="1.0.0" publishedMapName="World" 

descriptionConfig="dsConfig1" /> 

      </wfsServices> 

      <!--Configures the description of the WFS servive.--> 

      <wfsDescriptions> 

        <wfsDescription name="dsConfig1" 

source="descriptions\wfs_description.xml" /> 

        <wfsDescription name="dsConfig2" source="" /> 

      </wfsDescriptions> 

    </wfs> 

  </SuperMap.Web> 

  <!--The httpHandler mapping of each service request. The settings apply 

for IIS 7.--> 

  <system.webServer> 

    <handlers> 

      <add name="ImageHandler.ashx_*" path="ImageHandler.ashx" 

verb="*" type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="wfs_world.ashx_*" path="wfs_world.ashx" verb="*" 

type="SuperMap.IS.WebServices.WfsHandler, SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="wfs_changchun.ashx_*" path="wfs_changchun.ashx" 
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verb="*" type="SuperMap.IS.WebServices.WfsHandler, 

SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="wfs.ashx_*" path="wfs.ashx" verb="*" 

type="SuperMap.IS.WebServices.WfsHandler, SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

    </handlers> 

    <validation validateIntegratedModeConfiguration="false" /> 

  </system.webServer> 

</configuration>  

Saves this file in UTF-8 format to [SuperMap IS .NET Installation 

Directory]\Demo\SuperMapWFS folder, and names it as Web.config. 

Step 4: Using WFS service 

 Start map service. 

 Type the 

http://localhost/SuperMapWFS/wfs.ashx?map=World&SERVICE=WFS&REQUEST

=GetCapabilities&VERSION=1.0.0 in the browser to complete the operation of 

GetCapabilities, for example in the IE. The result is shown as in Figure 4-77. 

 

Figure 4-77: The GetCapabilities operation 

 Type the 
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http://localhost/SuperMapWFS/wfs.ashx?map=World&SERVICE=WFS&REQUEST

=DescribeFeatureType&VERSION=1.0.0 in the browser to complete the operation of 

DescribeFeatureType. The result is shown in the IE as in Figure 4-78. 

 

Figure 4-78: DescribeFeatureType operation 

 Type the 

http://localhost/SuperMapWFS/wfs.ashx?map=World&SERVICE=WFS&VERSION

=1.0.0&REQUEST=GetFeature&TYPENAME=world:World&SRS=EPSG:4326&BB

OX=-3,44,10,53 in the browser to complete the operation of GetFeature. The result is 

shown in the IE as in Figure 4-79. 



148                                                         Creating Web Applications 

Getting Started with SuperMap IS .NET 

 

Figure 4-79: GetFeature operation 

4.7.3 Publishing and using WCS service 

Step 1: Creating a new web site folder 

Create a new web site folder named SuperMapWCS for the service to be published 

located in [SuperMap IS .NET Installation Directory]\Demo, then copies the folders of 

bin and images under [SuperMap IS .NET Installation Directory]\WebServices to this 

new SuperMapWCS folder and new a folder names descriptions under the 

SuperMapWCS folder. 

Create the virtual directory for SuperMapWCS folder, the details please refer to the 

chapter 5. 

Step 2: Creating a description file for WCS service 

The description file is used to describe the information of WCS service, including 

service name, service title, keyword, the information about service publisher and etc. 

It is organized based of the OGC criterion. For details please refer to the criterion 

about OGC.  

1. Launching Visual Studio 2008. 
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2. Click File>New>File, then select XML files in the Template window. 

3. Add the following code to the XML file:  

<?xml version="1.0" encoding="UTF-8"?> 

<Service xmlns="http://www.opengis.net/wcs/1.1" 

xmlns:xlink="http://www.w3.org/1999/xlink"  

xmlns:owcs="http://www.opengis.net/wcs/1.1/ows" 

xmlns:ows="http://www.opengis.net/ows"> 

  <owcs:ServiceIdentification> 

    <ows:Title>SuperMap Corp. Coverage Service</ows:Title> 

    <ows:Abstract>A demonstration server used to illustrate world with 

the Web Coverage Service 1.1.0 implementation 

specification</ows:Abstract> 

    <ows:Keywords> 

      <!--The name for this type of service--> 

      <ows:Keyword>Web Coverage Service</ows:Keyword> 

      <ows:Keyword>world</ows:Keyword> 

      <ows:Keyword>Imagery</ows:Keyword> 

    </ows:Keywords> 

    <owcs:ServiceType>WCS</owcs:ServiceType> 

    <owcs:ServiceTypeVersion>1.1.0</owcs:ServiceTypeVersion> 

    <!--Fees or access constraints imposed. --> 

    <owcs:Fees>NONE</owcs:Fees> 

    <owcs:AccessConstraints>NONE</owcs:AccessConstraints> 

  </owcs:ServiceIdentification> 

  <!--Contact information--> 

  <ows:ServiceProvider> 

    <ows:ProviderName>SuperMap Corp.</ows:ProviderName> 

    <ows:ProviderSite xlink:href="http://www.supermap.com" /> 

    <ows:ServiceContact> 

      <ows:IndividualName>Taiwei Scientific-research 

Building</ows:IndividualName> 

      <ows:PositionName>JiancaiChengWest Road, Xisanqi Block Haidian 

District</ows:PositionName> 
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      <ows:ContactInfo> 

        <ows:Phone> 

          <ows:Voice>+86-10-82938424</ows:Voice> 

          <ows:Facsimile>+86-10-82938424</ows:Facsimile> 

        </ows:Phone> 

        <ows:Address> 

          <ows:DeliveryPoint>3/F Tower B</ows:DeliveryPoint> 

          <ows:DeliveryPoint>No.31</ows:DeliveryPoint> 

          <ows:City>Beijing</ows:City> 

          <ows:AdministrativeArea>Taiwei Scientific-research 

Building</ows:AdministrativeArea> 

          <ows:PostalCode>100096</ows:PostalCode> 

          <ows:Country>China</ows:Country> 

          

<ows:ElectronicMailAddress>support@supermap.com</ows:ElectronicMailAd

dress> 

        </ows:Address> 

        <ows:OnlineResource xlink:href="http://www.supermap.com" /> 

        <ows:HoursOfService>24x7x365</ows:HoursOfService> 

        <ows:ContactInstructions>email</ows:ContactInstructions> 

      </ows:ContactInfo> 

      <ows:Role>Developer</ows:Role> 

    </ows:ServiceContact> 

  </ows:ServiceProvider> 

</Service>  

Step 3: Configuring the Web.config file 

Web.config is the core file for publishing service, it includes the service name, the 

address and port of service to access, the data access protocol that supported, the 

HttpHandler mapped, service description and etc.. 

 Launching Visual Studio 2008. 

 Click File>New>File, then select XML files in the Template window. 
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 Add the following code to the Web configuration file:  

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <!--Describes the services types in <SuperMap.Web>--> 

    <sectionGroup name="SuperMap.Web" 

type="SuperMap.IS.Configuration.RootSectionGroup"> 

      <section name="wcs" type="SuperMap.IS.Configuration.WcsSection" 

/> 

    </sectionGroup> 

  </configSections> 

  <appSettings> 

    <add key="AppServer" value="127.0.0.1" /> 

    <add key="AppPort" value="8800" /> 

  </appSettings> 

  <connectionStrings /> 

  <system.web> 

    <compilation debug="true"> 

      <assemblies> 

        <add assembly="System.Design, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=B03F5F7F11D50A3A" /> 

        <add assembly="System.Windows.Forms, Version=2.0.0.0, 

Culture=neutral, PublicKeyToken=B77A5C561934E089" /> 

        <add assembly="System.Runtime.Serialization.Formatters.Soap, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=B03F5F7F11D50A3A" /> 

      </assemblies> 

    </compilation> 

    <authentication mode="Windows"/> 

    <!--The httpHandler mapping of the service request. The Settings apply 

for IIS 6.-> 

    <httpHandlers> 

      <add verb="*" path="wcs.ashx" 

type="SuperMap.IS.WebServices.WcsHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="ImageHandler.ashx" 
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type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" /> 

    </httpHandlers> 

  </system.web> 

  <SuperMap.Web> 

    <!--WCS configuration node--> 

    <wcs> 

      <wcsServices> 

        <!--Describes the communication manner and address of different 

request, version of the service, map to publish and the descripation 

information --> 

        <wcsService handlerPath="wcs.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="1.0.0" 

publishedMapName="" descriptionConfig="dsConfig1" /> 

      </wcsServices> 

      <!--The configuration of description information, including the name 

of service description and the path.--> 

      <wcsDescriptions> 

        <wcsDescription name="dsConfig1" 

source="descriptions\wcs_description_100.xml" /> 

        <wcsDescription name="dsConfig2" 

source="descriptions\wcs_description_110.xml" /> 

        <wcsDescription name="dsConfig3" source="" /> 

      </wcsDescriptions> 

    </wcs> 

  </SuperMap.Web> 

  <system.webServer> 

<!--The httpHandler mapping of the service request. The Settings apply 

for IIS 7.--> 

    <handlers> 

      <add name="ImageHandler.ashx_*" path="ImageHandler.ashx" verb="*" 

type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="wcs.ashx_*" path="wcs.ashx" verb="*" 

type="SuperMap.IS.WebServices.WcsHandler, SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

    </handlers> 

    <validation validateIntegratedModeConfiguration="false" /> 
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  </system.webServer> 

</configuration>  

Saves this file in UTF-8 format to [SuperMap IS .NET Installation 

Directory]\Demo\SuperMapWCS folder, and names it as Web.config. 

Step 4: Using WCS service 

 Start map service. 

 Type the:    

http://localhost/SuperMapWCS/wcs.ashx?map=DEM&SERVICE=WCS&REQUEST

=GetCapabilities&IDENTIFIER=DEM@dem&VERSION=1.1.0 in the browser to 

complete the operation of GetCapabilities, for example in the IE. The result is shown 

in Figure 4-80. 

 

Figure 4-80: GetCapabilities operation 

 Type the: 

http://localhost/SuperMapWCS/wcs.ashx?map=DEM&SERVICE=WCS&REQUEST

=DescribeCoverage&IDENTIFIER=DEM@dem&VERSION=1.1.0 in the browser to 

complete the operation of DescribeCoverage. The result is shown in the IE as in 

Figure 4-81. 
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Figure 4-81: DescribeCoverage operation 

 Type the: 

http://localhost/SuperMapWCS/wcs.ashx?map=DEM&SERVICE=WCS&REQUEST

=GetCoverage&VERSION=1.1.0&IDENTIFIER=DEM@dem&BOUNDINGBOX=&

FORMAT=image/png in the browser to complete the operation of GetCoverage. The 

result is shown in the IE as in Figure 4-82. 

 

Figure 4-82: GetCoverage operation 

 



Creating Web Applications                                                          155 

Getting Started with SuperMap IS .NET 

4.7.4 Publishing and using KML service 

Step 1: Creating a new web site folder 

Create a new web site folder named SuperMapKML for the service to be published 

located in [SuperMap IS .NET Installation Directory]\Demo, then copies the folders of 

bin and images under [SuperMap IS .NET Installation Directory]\WebServices to this 

new SuperMapKML folder. 

Create the virtual directory for SuperMapKML folder, the details please refer to the 

chaper 5.  

Step 2: Configuring the Web.config file 

The method is same with the configuration of WMS, here the contents of the 

configuration file has been introduced. 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <!--Describes the services types of <SuperMap.Web>.--> 

    <sectionGroup name="SuperMap.Web" 

type="SuperMap.IS.Configuration.RootSectionGroup"> 

      <section name="kml" type="SuperMap.IS.Configuration.KmlSection" 

/> 

    </sectionGroup> 

  </configSections> 

  <appSettings> 

    <add key="AppServer" value="127.0.0.1" /> 

    <add key="AppPort" value="8800" /> 

  </appSettings> 

  <connectionStrings /> 

  <system.web> 

    <compilation debug="true"> 

      <assemblies> 

        <add assembly="System.Design, Version=2.0.0.0, Culture=neutral, 
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PublicKeyToken=B03F5F7F11D50A3A" /> 

        <add assembly="System.Windows.Forms, Version=2.0.0.0, 

Culture=neutral, PublicKeyToken=B77A5C561934E089" /> 

        <add assembly="System.Runtime.Serialization.Formatters.Soap, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=B03F5F7F11D50A3A" /> 

      </assemblies> 

    </compilation> 

    <authentication mode="Windows"/> 

    <!--The httpHandler mapping of the service request. The Settings apply 

for IIS 6.--> 

    <httpHandlers> 

      <add verb="*" path="kml.ashx" 

type="SuperMap.IS.WebServices.KmlHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="kml_changchun.ashx" 

type="SuperMap.IS.WebServices.KmlHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="kml_world.ashx" 

type="SuperMap.IS.WebServices.KmlHandler, SuperMap.IS.WebServices" /> 

      <add verb="*" path="ImageHandler.ashx" 

type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" /> 

    </httpHandlers> 

  </system.web> 

  <SuperMap.Web> 

    <!--KML service configuration node.--> 

    <kml> 

      <!--KML service.--> 

      <kmlServices> 

        <!--Describes the data service communication manner and address 

of different request, version of the service, map which is published, 

service description, layers to be query and the number of maximal 

features.--> 

        <kmlService handlerPath="kml.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="2.1" 

publishedMapName="" queryLayersName="World@world" maxFeatures="100" /> 

        <kmlService handlerPath="kml_changchun.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="2.1" 

publishedMapName="changchun" 

queryLayersName="BuildingPoint@changchun" maxFeatures="100" /> 

        <kmlService handlerPath="kml_world.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="2.1" 
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publishedMapName="World" 

queryLayersName="Capital@world,Country_Lable@world" maxFeatures="500" 

descriptionConfig="dsConfig1" /> 

      </kmlServices> 

      <!--Description configuration, ot can describes the styles of point, 

lineand polygon in feature. --> 

      <kmlDescriptions> 

        <kmlDescription name="dsConfig1" pointNameField="Capital" 

pointDescriptionField="Capital" 

pointIconUrl="http://localhost/IS/WebServices/images/ylw-pushpin.png" 

lineNameField="CURR_TYPE7" lineDescriptionField="CURR_TYPE7" 

lineColor="997fff00" lineWidth="2" polygonNameField="Country" 

polygonDescriptionField="Country" polygonColor="ccb1a5a7" /> 

      </kmlDescriptions> 

    </kml> 

  </SuperMap.Web> 

  <!--The httpHandler mapping of the service request. The Settings apply 

for IIS 7. --> 

  <system.webServer> 

    <handlers> 

      <add name="ImageHandler.ashx_*" path="ImageHandler.ashx" verb="*" 

type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="kml_world.ashx_*" path="kml_world.ashx" verb="*" 

type="SuperMap.IS.WebServices.KmlHandler, SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="kml_changchun.ashx_*" path="kml_changchun.ashx" 

verb="*" type="SuperMap.IS.WebServices.KmlHandler, 

SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="kml.ashx_*" path="kml.ashx" verb="*" 

type="SuperMap.IS.WebServices.KmlHandler, SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

    </handlers> 

    <validation validateIntegratedModeConfiguration="false" /> 

  </system.webServer> 

</configuration>  

Save this file in UTF-8 format to [SuperMap IS .NET Installation 

Directory]\Demo\SuperMapKML folder, and names it as Web.config. 
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Step 3: Using KML service 

 Start map service. 

 Type the 

http://localhost/SuperMapKML/kml.ashx?map=World&BBOX=-155.444446123752,0

.10917135627867,-75.99834116562511,70.83724681145966 in the browser, for 

example in the IE. The result is shown as in Figure 4-83, then save this page as 

SuperMapKML.kml.  

 

Figure 4-83: Using KML service  

Make sure that this computer has connected to the network and has the Google Earth 

installed, double-click the SuperMapKML.kml to get the KML service, the result is 

shown as Figure 4-84.  
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Figure 4-84: Gets KML service through GoogleEarth 

4.7.5 Publishing and using GeoRSS service 

Step 1: Creating a new web site folder 

Create a new web site folder named SuperMapGeoRSS located in [SuperMap IS .NET 

Installation Directory]\Demo, then copies the folders of bin and images under 

[SuperMap IS .NET Installation Directory]\WebServices to this new 

SuperMapGeoRSS folder. 

Create the virtual directory for SuperMapGeoRSS folder, the details please refer to the 

chaper 5.    

Step 2: Configuring the Web.config file 

The method is same with the configuration of WMS, here is the contents of the 

configuration file. 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 
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    <!--Describes the services types of <SuperMap.Web>. --> 

    <sectionGroup name="SuperMap.Web" 

type="SuperMap.IS.Configuration.RootSectionGroup"> 

      <section name="georss" 

type="SuperMap.IS.Configuration.GeoRssSection" /> 

    </sectionGroup> 

  </configSections> 

  <appSettings> 

    <add key="AppServer" value="127.0.0.1" /> 

    <add key="AppPort" value="8800" /> 

  </appSettings> 

  <connectionStrings /> 

  <system.web> 

    <compilation debug="true"> 

      <assemblies> 

        <add assembly="System.Design, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=B03F5F7F11D50A3A" /> 

        <add assembly="System.Windows.Forms, Version=2.0.0.0, 

Culture=neutral, PublicKeyToken=B77A5C561934E089" /> 

        <add assembly="System.Runtime.Serialization.Formatters.Soap, 

Version=2.0.0.0, Culture=neutral, PublicKeyToken=B03F5F7F11D50A3A" /> 

      </assemblies> 

    </compilation> 

    <authentication mode="Windows" /> 

    <!--The httpHandler mapping of the service request. The Settings apply 

for IIS 6.--> 

    <httpHandlers> 

      <add verb="*" path="georss.ashx" 

type="SuperMap.IS.WebServices.GeoRssHandler, 

SuperMap.IS.WebServices" /> 

      <add verb="*" path="ImageHandler.ashx" 

type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" /> 

    </httpHandlers> 

  </system.web> 

  <SuperMap.Web> 

    <!--GeoRSS service configuration node.--> 
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    <georss> 

      <!--GeoRSS service.--> 

      <georssServices> 

        <!-- Describes the data service communication manner and address 

of different request, version of the service, map which is published, 

service description and the layers to be published. --> 

        <georssService handlerPath="georss.ashx" 

dataServiceEndpoint="net.tcp://localhost:8800" defaultVersion="2.0" 

publishedMapName="" 

        queryLayersName="World@world"/> 

      </georssServices> 

      <!--The configuration of the service description.--> 

      <georssDescriptions> 

        <georssDescription name="dsConfig1" source="" /> 

      </georssDescriptions> 

    </georss> 

  </SuperMap.Web> 

  <system.webServer> 

    <handlers> 

      <add name="ImageHandler.ashx_*" path="ImageHandler.ashx" 

verb="*" type="SuperMap.IS.Web.ImageHandler, SuperMap.IS.WebLib" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

      <add name="georss.ashx_*" path="georss.ashx" verb="*" 

type="SuperMap.IS.WebServices.GeoRssHandler, 

SuperMap.IS.WebServices" 

preCondition="integratedMode,runtimeVersionv2.0" /> 

    </handlers> 

    <validation validateIntegratedModeConfiguration="false" /> 

  </system.webServer> 

</configuration> 

Saves this file in UTF-8 format to [SuperMap IS .NET Installation 

Directory]\Demo\SuperMapGeoRSS folder, and names it as Web.config. 

Step 3: Using GeoRSS service 

 Start map service. 
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 Open a browser which supports the function of RSS, for example IE. Types 

the address of http://localhost/SuperMapGeoRSS/georss.ashx?map=World, the result 

is as shown in Figure 4-85. 

 

Figure 4-85: Gets the GeoRSS service (IE) 

 Open a browser which supports the function of RSS, for example Mozilla 

Firefox. Types the address of 

http://localhost/SuperMapGeoRSS/georss.ashx?map=World, the result is  as shown 

in Figure 4-86.  
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Figure 4-86: Gets the GeoRSS service (Mozilla Firefox) 

Click Subscribe Now button to get the aggregation service of the geography 

information.  
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5  How to Publish 

Website  

After developing these web applications, you should publish them to network for users 

to access. 

A website needs servers in three types: data server, Web server and GIS server. These 

three servers can be in one computer or more. 

1. Prepare data: data is required for the applications (SuperMap Deskpro or other 

software can be used here). The data can be saved in file format if it is not too large, 

otherwise it can be saved in database.  

2. Move the applications to Web server and modifies the IP address and 

ports.(Figure 5-1)  

3. Create virtual directory for the applications. 

4. Set the IP address and TCP port of IIS (as shown in Figure 5-2 ), select Advanced 

in Figure 5-2 to set the advances setting of the website. 

Chapter 
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5. Config IS. Open SuperMap IS Manager, and then click IS Config in the first page 

as shown in Figure 5-3. The system setting, GIS server setting and others parameters 

can be set here, click Save button to save these settings in Figure 5-4. 

6. Open IE and type the service address you want to access, such as  

http://application virtual address in step 4/application name. 

(http://localhost/IS/AjaxDemo/default.aspx). 

  

Figure 5-1: Set the IP address and port  Figure 5-2: Set IIS 

  

Figure 5-3: The ISManager  Figure 5-4: Config IS 
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